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About This Document

Purpose
This document describes the features of the IN300 standard PCIe FC HBA cards, how to
upgrade the software, and how to install and use the management tool.

NOTE

The IN300 supports two types of brackets: full-height and half-height brackets. All figures in this
document use the full-height bracket as an example.

Intended Audience
This document is intended for:

l Enterprise administrators
l Enterprise end users

Symbol Conventions
The symbols that may be found in this document are defined as follows.

Symbol Description

Indicates an imminently hazardous situation which, if
not avoided, will result in death or serious injury.

Indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

Indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.

Indicates a potentially hazardous situation which, if not
avoided, could result in equipment damage, data loss,
performance deterioration, or unanticipated results.
NOTICE is used to address practices not related to
personal injury.
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Symbol Description

Calls attention to important information, best practices
and tips.
NOTE is used to address information not related to
personal injury, equipment damage, and environment
deterioration.

 

Change History
Changes between document issues are cumulative. The latest document issue contains all the
changes made in earlier issues.

Issue Date Description

08 2019-07-27 This issue is the eighth official release.
Deleted "NOTE" of "Hardware Requirements"
in 1.5 System Requirements.

07 2019-07-15 This issue is the seventh official release.
l Modified 1.3 Features.
l Modified 1.5 System Requirements.
l Added 3.4.32 Querying the Link Timeout

Interval (fc_get_link_tmo) ~ 3.4.35
Reading Chip Register Values in Batches
(csr_dump).

06 2019-05-10 This issue is the sixth official release.
l Added 1.3 Features.
l Added information about the installation,

upgrade, and uninstallation of drivers on
the Neokylin, Linx, and Red Flag OSs in
2.2 Maintaining the Driver.

l Added information about installing,
upgrading, and uninstalling the hifcadm
tool on the Neokylin, Linx, and Red Flag
OSs in 3 Management Tool hifcadm.

l Added 5 Configuring SAN Boot.

05 2019-01-30 This issue is the fifth official release.
Added the information about Microsoft
Windows.

04 2018-11-30 This issue is the fourth official release.
l Added the information about the SP522.
l Added the information about VMware

ESXi.
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Issue Date Description

03 2018-09-11 This issue is the third official release.
Modified supported commands.

02 2018-08-10 This issue is the second official release.
Modified supported commands.

01 2018-05-20 This issue is the first official release.
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1 Getting to Know the IN300

1.1 Overview

1.2 Physical Structure

1.3 Features

1.4 Specifications

1.5 System Requirements

1.1 Overview
The IN300 FC HBAs are IN300 series standard PCIe cards that are used on Huawei servers to
provide external service ports.

l The Huawei IN300 2*8Gb provides two 8G SFP+ optical ports.
l The Huawei IN300 2*16Gb provides two 16G SFP+ optical ports.
l The Huawei IN300 2*32Gb provides two 32G SFP+ optical ports.

The IN300 are FC HBAs using the Huawei HiSilicon high-performance FC chip. Both
support applications connected to the FC network and implement high-bandwidth and high-
performance storage networking. The IN300 support PCIe 3.0 x8 and I2C (Inter-integrated
Circuit) out-of-band management.

1.2 Physical Structure

Components
Figure 1-1 shows the components of the IN300.
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Figure 1-1 IN300 components

1 Bracket 2 PCIe connector

3 FC chip+heat sink 4 Mainboard

 

Table 1-1 describes the components of the IN300.

Table 1-1 IN300 component description

Component Description

Mainboard Includes the FC HBA module, FC port module, and power
module.

FC chip HBA chip that implements FC functions.

Heat sink Cools the HBA chip.

Bracket HBA bracket, which can be full-height or half-height.

PCIe connector Connects to a PCIe slot on the server.

 

Panel

Figure 1-2 shows the panel of the IN300.

Figure 1-2 Panel

Huawei IN300 FC HBA Card
User Guide 1 Getting to Know the IN300

Issue 08 (2019-07-27) Copyright © Huawei Technologies Co., Ltd. 2



1 Speed indicator 2 Link/Active indicator

3 SFP+ optical port 2 4 SFP+ optical port 1

 

Indicators
The indicators display the working status of the IN300. Table 1-2 describes the indicators on
the panel of the IN300.

Table 1-2 Indicator description

Indicator Meaning Color Description

Link/Active
indicator

Network
connection
status
indicator

Green l Off: No optical module is inserted or the
inserted optical module is not identified.

l Steady on: A link is established.
l Blinking (1 Hz): No link is established.
l Blinking (2 Hz): A link is established and

data is being transmitted.
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Indicator Meaning Color Description

Speed
indicator

Network
data
transmissio
n status
indicator

Yellow and
green

l Huawei IN300 2*8Gb:
– Off: No optical module is inserted, the

inserted optical module is not identified,
or the transmission rate is 2 Gbit/s.

– Blinking green (1Hz): No link is
established.

– Steady yellow: A 4 Gbit/s link is
established.

– Steady green: A 8 Gbit/s link is
established.

l Huawei IN300 2*16Gb:
– Off: No optical module is inserted, the

inserted optical module is not identified,
or the transmission rate is 4 Gbit/s.

– Blinking green (1Hz): No link is
established.

– Steady yellow: A 8 Gbit/s link is
established.

– Steady green: A 16 Gbit/s link is
established.

l Huawei IN300 2*32Gb:
– Off: No optical module is inserted, the

inserted optical module is not identified,
or the transmission rate is 8 Gbit/s.

– Blinking green (1 Hz): No link is
established.

– Steady yellow: A 16 Gbit/s link is
established.

– Steady green: A 32 Gbit/s link is
established.

NOTE
When an optical module is inserted and identified but the link is not set up, both indicators will blink
green at the same time.

 

1.3 Features
The features of the IN300 are as follows:

l Half-height half-length PCIe x8 card with a half-height or full-height bracket, applicable
for various application scenarios.

l A Huawei dedicated chip on the x86 platform. Huawei IN300 2*8Gb provides two 8G
FC ports, which are backward compatible with the 4G and 2G rates. Huawei IN300
2*16Gb provides two 16G FC ports, which are backward compatible with the 8G and 4G
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rates. Huawei IN300 2*8Gb provides two 32G FC ports, which are backward compatible
with the 16G and 8G rates.

l point-to-point service (P2P), Loop (8G or lower), and Fabric topologies.
l FC Buffer to buffer flow control management mechanism.
l Credit recovery in P2P/Fabric topology mode. This function is disabled by default.
l SAN Boot function in Unified Extensible Firmware Interface (UEFI) modes.
l Rate auto-negotiation.
l Topology auto-negotiation.
l RS-FEC for 32G ports. This function is enabled by default.
l KR-FEC for 16G ports. This function is disabled by default.

1.4 Specifications
Table 1-3 describes the specifications of the IN300.

Table 1-3 Basic specifications

Item Specifications

Form factor Low-profile NIC, supporting a full-height or half-height
bracket

PCIe connector PCIe x8 port, compatible with x4/x2/x1; PCIe 3.0, compatible
with PCIe 2.0/1.0

Chip Huawei HiSilicon HBA chip

FC port l Huawei IN300 2*8Gb: provides two 8G/4G/2G FC service
ports.

l Huawei IN300 2*16Gb: provides two 16G/8G/4G FC
service ports.

l Huawei IN300 2*32Gb: provides two 32G/16G/8G/4G
service ports.
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Item Specifications

FC specification/protocol l Fibre Channel Framing and Signaling-2 (FC-FS-2)
l Fibre Channel Framing and Signaling-3 (FC-FS-3)
l Fibre Channel Framing and Signaling-3 (FC-FS-4)
l Fibre Channel Physical and Signaling Interface-3 (FC-

PH-3)
l Fibre Channel Arbitrated Loop-2 (FC-AL-2)
l Fibre Channel Methodologies for Interconnects-2 (FC-

MI-2)
l Fibre Channel Tape and Tape Medium Changers (FC-

TAPE)
l Fibre Channel Protocol For SCSI-2 (FCP-2)
l Fibre Channel Protocol For SCSI-3 (FCP-3)
l Fibre Channel Protocol For SCSI-4 (FCP-4)
l Fibre Channel Link Services-2 (FC-LS-2)
l Fibre Channel Link Services-3 (FC-LS-3)
l Fibre Channel Generic Services-4 (FC-GS-4)
l Fibre Channel Generic Services-5 (FC-GS-5)
l Fibre Channel Generic Services-6 (FC-GS-6)
l Fibre Channel Physical Interface-4 (FC-PI-4)
l Fibre Channel Physical Interface-5 (FC-PI-5)
l Fibre Channel Physical Interface-6 (FC-PI-6)
l Fibre Channel - Methodologies for Jitter and Signal Quality

Specification(FC-MJSQ)
l Fibre Channel - Methodologies for Signal Quality

Specification(FC-MSQS)
l Fibre Channel - Methodologies for Signal Quality

Specification-2(FC-MSQS-2)

Performance l Huawei IN300 2*8Gb: supports bidirectional bandwidth of
1,200,000 IOPS and 3200 Mbyte/s.

l Huawei IN300 2*16Gb: supports bidirectional bandwidth
of 1,700,000 IOPS and 6400 Mbyte/s.

l Huawei IN300 2*32Gb: supports bidirectional bandwidth
of 1,700,000 IOPS and 12800 Mbyte/s.

Reliability assurance
function

l FEC (Forward error correction)
l BB_CR (Buffer-to-Buffer Credit Recovery)

Mean time between
failures (MTBF)

174324 hours

Mean time to repair
(MTTR)

180 seconds
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1.5 System Requirements

Hardware Requirements

The IN300 needs to be installed in a standard PCIe x8 or x16 slot.

Software Requirements

Table 1-4 lists Linux OSs supported by the IN300, Table 1-5 lists supported VMware
hypervisors, Table 1-6 lists supported Windows hypervisors.

Table 1-4 Compatible Linux OSs

OS x86 Version ARM Version

CentOS 6.9/6.10/7.2/7.3/7.4/7.5/7.6 7.6

Neokylin 6.9/7.4 V7.0U6

RedFlag 7.3 -

SLES 11.4/12.2/12.3/12.4/15 -

RHEL 6.9/6.10/7.1/7.2/7.3/7.4/7.5/
7.6

-

UVP - 3.0

Ubuntu 18.04.0/18.04.1 18.04.2

Oracle 6.9/7.3/7.5/7.6 -

Linx 6.0.80 -

EulerOS - V2.0 SP8

 

Table 1-5 Compatible VMware hypervisor

Hypervisor x86 Version

VMware ESXi 6.0.3/6.5/6.5.1/6.5.2/6.7/6.7.1

 

Table 1-6 Compatible Windows

Windows x86 Version

Microsoft Windows Windows Server 2012 R2/Windows Server 2016/Windows
Server 2019
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NOTE

The preceding OSs are for reference only. For details about the OSs that can be purchased, see the
Intelligent Computing Compatibility Checker or consult the local Huawei sales representatives.

Peripheral Requirements
Table 1-7 lists the peripheral devices supported by the IN300.

Table 1-7 Compatible peripheral devices

Type Model

Switch Huawei OceanStor SNS2124/2224/2248/3096

Huawei OceanStor SNS2624/3664/5604/5608

Huawei OceanStor SNS2120/5120

Brocade 300/5100/5300/6510/G610/G620/G630/200E/
DCX8510

Cisco Nexus 5548/5596

Cisco MDS 9148/9509/9513/9706/9132T/9250i

Storage Huawei OceanStor 2100/2200/2600/2800 V3

Huawei Oceanstor 5300/5500/5600/5800 V3

Huawei OceanStor Dorado 5000/6000 V3

Huawei Oceanstor 6800/6900/18500/18800 V3

Huawei Oceanstor 2800/5300/5500/5600/5800 V5

Huawei Oceanstor 6800/18500/18800 V5

HDS AMS 2500/VSP G200/HUS VM

HPE P2000/4000/6000/EVA8100/EVA4400/MSA2000/3PAR
F200

IBM DS4000/5000/6000/SVC/XIV/Huawei S3200(DS4700)

EMC VNX5400/VNX5300/VPLEX/Xtrem IO

NetApp FAS series (8040)/V3160

SUN ST6140

Fujitsu DX80/DX60

DELL PS4000E

MacroSAN MS2500G2
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For more information about the IN300 compatibility, see the Intelligent Computing
Compatibility Checker.
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2 Installation and Maintenance

The IN300 is a standard PCIe card and can be installed in the same way as a common NIC.
For details about how to install the IN300, see the server user guide. This document describes
only IN300 driver and firmware installation and maintenance.

2.1 Obtaining Software Packages

2.2 Maintaining the Driver

2.3 Upgrading the Firmware

2.1 Obtaining Software Packages

Downloading Installation Packages

Step 1 Log in to the Huawei Enterprise Website.

Step 2 Choose TECHNICAL SUPPORT > Product Support > Accelerator Components >
IN500 Solution.

Step 3 Click the software Download tab.

Step 4 Click the target version.

Step 5 Download the software package required (IN500_solution_5.1.0.zip).

NOTE

The IN200/IN300/IN500 software package is named IN500_solution_5.1.0.zip or
IN500_solution_5.1.0.SPCXXX.zip.

Step 6 Decompress the software package.Table 2-1 lists the software packages to be downloaded.

NOTE

You can obtain the VMware drivers of the IN300 from the official Huawei website or VMware website.
On the VMware website, you can search for the drivers by using "Huawei IN300 Fibre Channel
Adapter" as the key words.
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Table 2-1 Required software packages

Software
Package
Type

OS Type Path Format Installation
Method

Driver
package

Linux driver\linux\fc\OS
name\

*.rpm 2.2
Maintaining
the Driver

(Linux)
Ubuntu/Linx

driver\linux\fc\OS
name\

*.deb

VMware driver\vmware\fc
\OS name\
NOTE

The driver package
contains the
hifcadm tool
package. After the
driver is installed,
the hifcadm tool is
automatically
installed.

*.vib

Windows driver\windows\fc
\OS name\

*.msi

Firmware
upgrade
package

- l firmware
\update_bin
\cfg_data_fc_p
rd_1h_4x8G\

l firmware
\update_bin
\cfg_data_fc_p
rd_1h_4x16G\

l firmware
\update_bin
\cfg_data_fc_p
rd_1h_4x32G\

*.bin 2.3 Upgrading
the Firmware

Firmware log
offline
parsing
dictionary
file

- firmware
\dictionary

*.index -

hifcadm tool
package

Linux tools\linux\fc\ *.rpm 3 Management
Tool hifcadm

(Linux)
Ubuntu/Linx

tools\linux\fc\ *.deb
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Software
Package
Type

OS Type Path Format Installation
Method

Linux tools\linux\fc
\collect_scripts
NOTE

This is a one-click
information
collection script,
which is also
applicable to the
ARM platform.

*.sh

Windows tools\windows\fc
\OS name\

*.msi

 

----End

NOTE

l You are advised to use the latest driver, firmware, and management tool released on Huawei
enterprise service website (https://e.huawei.com/en/).

l Ensure that the version of the firmware used for installation or upgrade is not earlier than the driver
version. For example, if the driver version is 1.8.2.7, the firmware version must be 1.8.2.7 or a later.

l After the driver is upgraded, you must also upgrade the firmware and management tool.

Verifying Installation Package Integrity

Verify that the obtained installation packages are the same as those at the website.

On the download page, click  to obtain the digital software certificate, and click  to
download the software.

Obtain the verification tool and method from Digital Signature Verification Tool.

2.2 Maintaining the Driver

2.2.1 Preparations (SUSE Linux)
The IN300 has been certificated by SUSE. Before installing, or upgrading drivers for SUSE
Linux, you need to import the SUSE Linux PLDP UEFI certificate (mandatory in the Secure
Boot mode) and gpg public key of the installation package.

(Optional) Importing the SUSE PLDP Certificate

Before installing the IN300 driver on the server in the BIOS UEFI safe mode, import the
SUSE PLDP UEFI certificate in the BIOS to support the certificated IN300 driver.

Step 1 Obtain the SUSE Linux PLDP UEFI certificate.

For details about the certificate address, see 2.1 Obtaining Software Packages.
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Step 2 Import the SUSE Linux PLDP UEFI certificate to the BIOS.

On the BIOS screen, choose Administer Secure Boot > DB Options > Enroll Signature and
import the SUSE LDAP UEFI certificate. After the certificate is imported, PLDP Secure
Boot Signing Key is displayed in the DB Signature List, as shown in Figure 2-1.

Figure 2-1 Importing a certificate

For details, see the server BIOS parameter reference.

----End

Importing the SUSE gpg Public Key

You only need to import the gpg public key of the SUSE installation package once.

Step 1 Obtain the SUSE gpg public key.

For details about the certificate address, see 2.1 Obtaining Software Packages.

Step 2 Upload the public file such as gpg-pubkey-c2bea7e6-4c2de264.asc to any directory of the
operating system on the server.

Step 3 Run the rpm --import command to import the public key to the operating system.

Example:
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rpm --import gpg-pubkey-c2bea7e6-4c2de264.asc

----End

2.2.2 Installing the Driver

Prerequisites
l The driver package of the IN300 has been downloaded.

For the package name and download method, see 2.1 Obtaining Software Packages.
l The driver package has been uploaded to the server OS.
l The IN300 driver has not been installed on the server.

Impact
It takes about 30 seconds to install the driver. The installation process cannot be interrupted.
During the installation, the server OS cannot be restarted. Otherwise, the server OS may be
abnormal or cannot be started.

Installing the Driver on Linux

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the directory where the driver package is stored.

Step 3 Install the driver package.

If the OS is RHEL, CentOS, Oracle, SUSE, UVP, RedFlag, or Neokylin, run the rpm -ivh
<driver software package name> command to install the driver package..

Using RHEL as an example:

[root@localhost RedHat 6.9_1128]# rpm -ivh kmod-
hifc-1.5.2.0_2.6.32_696-1.el6.x86_64.rpm
Preparing...                ########################################### [100%]
        package kmod-hifc-1.5.2.0_2.6.32_696-1.el6.x86_64 is already installed

NOTE

If the RPM package is not signed, before installing the driver package, perform the following
operations:
1. run the vim /etc/modprobe.d/10-unsupported-modules.conf command and change the value of

allow_unsupported_modules to 1.
vim /etc/modprobe.d/10-unsupported-modules.conf

2. Run the rpm -checksig hifc-kmp-default-<version>-<distribution>.<arch>.rpm command to make
the certificated driver package take effect.
rpm -checksig hifc-kmp-default-1.4.3.0_k4.4.73_5-100R.4.1.x86_64.rpm
hifc-kmp-default-1.4.3.0_k4.4.73_5-100R.4.1.x86_64.rpm: rsa sha1 (md5) pgp 
md5 OK

Step 4 Make the driver take effect.

You can use either of the following methods to make the driver take effect. Select one as
required.

l Method 1
Run the reboot command on the OS.
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l Method 2
Run the following commands in sequence in the OS:
rmmod hifc
modprobe hifc

----End

Installing the Driver on (Linux) Ubuntu/Linx

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the directory where the driver package is stored.

Step 3 Install the driver package.

Run the dpkg -i <driver software package name> command to install the driver package..

Using Ubuntu as an example:
root@ubuntu1804:~# dpkg -i hifc-1.8.2.3-4.15.0_20_generic.ubuntu.amd64.deb
(Reading database ... 65984 files and directories currently installed.)
Preparing to unpack hifc-1.8.2.3-4.15.0_20_generic.ubuntu.amd64.deb ...
Unpacking hifc (1.8.2.3) ...
Setting up hifc (1.8.2.3) ...
Installing... Please wait for a moment.
Install hifc driver package successfully.

Step 4 Make the driver take effect.

You can use either of the following methods to make the driver take effect. Select one as
required.

l Method 1
Run the reboot command on the OS.

l Method 2
Run the following commands in sequence in the OS:
rmmod hifc
modprobe hifc

----End

Installing the Driver on VMware ESXi

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the directory where the driver package is stored, for example, /tmp.

Step 3 Install the driver package.

Run the esxcli software vib install -v hifc-<version>-<kernel_version>.<arch>.vib
command.

NOTE

Enter a full path after -v.
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Example:

esxcli software vib install -v /tmp/hifc-1.5.0.0-1OEM.650.0.0.4598673.x86_64.vib
Installation Result
   Message: The update completed successfully, but the system needs to be 
rebooted for the changes to be effective.
   Reboot Required: true
   VIBs Installed: Huawei_bootbank_hifc_1.8.2.0-1OEM.600.0.0.2768847
   VIBs Removed:  
   VIBs Skipped:

Step 4 Run the reboot command to restart VMware ESXi for the driver to take effect.

----End

Installing the Driver on Microsoft Windows

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the directory where the driver package is stored, for example, "C:\".

Step 3 Install the driver package.

Double-click hifc_<version>_<Windows_OS>_x86_64.msi to install the driver package.

NOTE

Select Complete for Choose Setup Type.

Step 4 The driver takes effect after the installation. You are advised to restart Microsoft Windows
after the installation.

----End
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If an exception occurs during the installation (for example, the server is restarted or powered
off), handle the problem by referring to A.1 An Exception Occurs During Driver
Installation or Uninstallation.

Follow-up Procedure

After the driver is installed, you can operate the following steps.

1. Run the lsmod | grep hifc command on Linux or vmkload_mod -l | grep hifc command
on VMware ESXi to check whether the driver has taken effect.
– If no command output is displayed, the driver has not taken effect, and you need to

perform the operation again.
– If the command output about the IN300 driver is displayed, the driver has taken

effect.
2. Run the version command to query the current driver version using hifcadm.
3. In Microsoft Windows, you can scan for hardware detection changes in the Device

Manager and check whether the driver has been installed on the IN300 and whether the
driver has been identified.
For example:

2.2.3 Upgrading the Driver

Prerequisites
l The IN300 driver already exists on the server OS.
l The new driver package of the IN300 has been downloaded.

For the package name and download method, see 2.1 Obtaining Software Packages.
l The new driver package has been uploaded to the server OS.
l In Linux, before upgrading the driver, ensure that the key has been correctly installed in

the system. For details about how to download and install the key, see https://
drivers.suse.com/doc/Usage/Package_Signing_Key.html#package-signing-key.

l On the Windows OS, ensure that no program occupies the original driver file (hifc.sys)
before upgrading the driver. Otherwise, the system prompts you to restart the system
during the upgrade and the upgrade fails. If the upgrade fails, check whether the fault is
caused by the preceding situation.

l Before upgrading the driver on Microsoft Windows, you must power off VMs where the
Hyper-V NPIV function is enabled.

Constraints
l The target version must be later than the source version.
l If the target version is earlier than or the same as the source version, the upgrade fails.
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l If you want to roll back to an earlier version, you need to uninstall the current driver
and then install the new driver.

Impact
The upgrade process cannot be interrupted. During the upgrade, the server OS cannot be
restarted. Otherwise, the server OS may be abnormal or cannot be started.

Upgrading the Driver on Linux

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the directory where the driver package is installed.

Step 3 Upgrade the driver package.

If the OS is RHEL, CentOS, Oracle, SUSE, UVP, RedFlag, or Neokylin, run the rpm -Uvh
<driver software package name> command to upgrade the driver package.

Using RHEL as an example:
rpm -Uvh kmod-hifc-1.2.3.0_3.10.0_514-1.el7.x86_64.rpm
Preparing...                ########################################### [100%]
          package kmod-hifc-1.2.3.0_3.10.0_514-1.el7.x86_64 is already installed

Step 4 Make the new driver take effect.

You can use either of the following methods to make the driver take effect. Select one as
required.
l Method 1

Run the reboot command on the OS.
l Method 2:

a. Check that the current IN300 program has stopped.
b. Run the modprobe -r hifc on the OS to install the existing driver.
c. Run the modprobe hifc command on the OS to load the new driver.

----End

NOTE

When SAN Boot is used, run the dracut --add-drivers "hifc.ko hifc_sdk.ko" --force command after
the driver is upgraded to forcebly add the driver to initrd.

Upgrading the Driver on (Linux) Ubuntu/Linx

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the directory where the driver package is installed.

Step 3 Run the dpkg -i <driver software package name> command to upgrade the driver package.

Using Ubuntu as an example:
root@ubuntu1804:~# dpkg -i hifc-1.8.23-4.15.0_20_generic.ubuntu.amd64.deb
(Reading database ... 65986 files and directories currently installed.)
Preparing to unpack hifc-1.8.2.3-4.15.0_20_generic.ubuntu.amd64.deb ...
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Unpacking hifc (1.8.2.3) over (1.8.2.3) ...
Uninstalling... Please wait for a moment.
Uninstall hifc driver package successfully.
Setting up hifc (1.8.2.3) ...
Installing... Please wait for a moment.
Install hifc driver package successfully.

Step 4 Make the new driver take effect.

You can use either of the following methods to make the driver take effect. Select one as
required.
l Method 1

Run the reboot command on the OS.
l Method 2:

a. Check that the current IN300 program has stopped.
b. Run the modprobe -r hifc on the OS to install the existing driver.
c. Run the modprobe hifc command on the OS to load the new driver.

----End

Upgrading the Driver on VMware ESXi
l To update the driver to a later version, perform operations in 2.2.2 Installing the Driver.

The system automatically replaces the original vib driver package based on the version
and restarts for the update to take effect.

l To update the driver to an earlier version, perform operations in 2.2.4 Uninstalling the
Driver, restart the system, and then perform the operations in 2.2.2 Installing the
Driver. The update takes effect after restart.

Upgrading the Driver on Microsoft Windows

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the directory where the driver package is stored, for example, "C:\".

Step 3 Upgrade the driver package.

Double-click hifc_<version>_<Windows_OS>_x86_64.msi to install the driver package.
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NOTE

l Select Complete for Choose Setup Type.

l The target version must be later than the source version; otherwise, uninstall the driver package and
install a later one.

Step 4 Restart Microsoft Windows after the installation, the driver takes effect.

----End

Follow-up Procedure

After the driver is installed, you can run the version command to query the current driver
version using hifcadm.

2.2.4 Uninstalling the Driver

Prerequisites

The IN300 driver already exists on the server OS.

Impact

During the uninstallation, the server OS cannot be restarted. Otherwise, the server OS may be
abnormal or cannot be started.

Uninstalling the Driver from Linux

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.
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Step 2 Go to the installation directory where the driver is installed.

Step 3 Uninstall the driver.

If the OS is RHEL, CentOS, Oracle, SUSE, UVP, RedFlag, or Neokylin, run the rpm -Uvh
<driver software package name> command to uninstall the driver.

Using RHEL as an example:

rpm -e kmod-hifc-1.2.3.0_3.10.0_514-1.el7.x86_64

NOTE

You can run the rpm -qa | grep hifc command to query the driver software package name.

Step 4 Make the uninstallation operation take effect.

You can use either of the following methods to make the uninstallation operation take effect.
Select one as required.

l Method 1
Run the reboot command on the OS.

l Method 2

a. Check that the current IN300 program has stopped.
b. Run the following commands in sequence in the OS:

n rmmod hifc
n rmmod hifc_sdk

----End

Uninstalling the Driver from (Linux) Ubuntu/Linx

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the installation directory where the driver is installed.

Step 3 Uninstall the driver

Run the dpkg -r hifc command to uninstall the driver.
root@ubuntu1804:~# dpkg -r hifc
(Reading database ... 65985 files and directories currently installed.)
Removing hifc (1.8.2.3) ...
Uninstalling... Please wait for a moment.
Uninstall hifc driver package successfully.

Step 4 Make the uninstallation operation take effect.

You can use either of the following methods to make the uninstallation operation take effect.
Select one as required.

l Method 1
Run the reboot command on the OS.

l Method 2

a. Check that the current IN300 program has stopped.
b. Run the following commands in sequence in the OS:
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n rmmod hifc
n rmmod hifc_sdk

----End

Uninstalling the Driver from VMware ESXi

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the directory where the driver package is installed.

Step 3 Uninstall the driver.

For example, to uninstall the driver, run the esxcli software vib remove -n hifc command.

esxcli software vib remove -n hifc
Message: The update completed successfully, but the system needs to be rebooted 
for the changes to be effective.
   Reboot Required: true
   VIBs Installed: 
   VIBs Removed: Huawei_bootbank_hifc_1.8.2.3-1OEM.650.0.0.4598673
   VIBs Skipped:

Step 4 Run the reboot command to restart VMware ESXi.

----End

Uninstalling the Driver from Microsoft Windows

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Click , choose Control Panel > Programs and Features.

Step 3 Right-click the HifcDriver program name and choose Uninstall/Change from the short-cut
menu.

----End

NOTE

If an exception occurs during the uninstallation (for example, the server is restarted or powered off),
handle the problem by referring to A.1 An Exception Occurs During Driver Installation or
Uninstallation.

2.3 Upgrading the Firmware

Prerequisites
l The IN300 driver has been installed.
l The IN300 firmware upgrade package has been downloaded.

For the package name and download method, see 2.1 Obtaining Software Packages.
l The upgrade package has been uploaded to the server OS.
l The hifcadm tool has been installed.
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Impact
The upgrade process cannot be interrupted. During the upgrade, the server OS cannot be
restarted. Otherwise, the server OS may be abnormal or cannot be started.

Procedure

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the directory where the upgrade package is stored.

Step 3 Upgrade the firmware and make the upgrade take effect.

1. Run the hifcadm updatefw -i <FC device name> -f <Firmware file path> command.
In this command, FC device name is the name of the FC card in the system. For
example, hifc0 indicates the first FC card, and hifc1 indicates the second FC card.
# hifcadm updatefw -i hifc0 -f fc_prd_1h_2x32G.bin
Please do not remove driver or network device.
Loading...
Firmware update start: 2019-03-20 13:09:29
[>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>] [100%][\]
Firmware update finish: 2019-03-20 13:09:35
Firmware update time used: 6s
Loading firmware image succeed.
Please reboot OS to take firmware effect.

2. Run the reboot command for the upgrade to take effect.

----End

Follow-up Procedure
After the firmware upgrade is complete, you can run the hifcadm version -i hifcX command
to query the IN300 firmware version to confirm that the upgrade is successful.
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3 Management Tool hifcadm

The hifcadm is a management tool customized for the IN300. You can use this tool to manage
the IN300.

3.1 Installing hifcadm

3.2 Using hifcadm

3.3 Command List

3.4 Command Reference

3.5 Upgrading hifcadm

3.6 Uninstalling hifcadm

3.1 Installing hifcadm

Prerequisites
l The hifcadm installation package has been downloaded.

For the package name and download method, see 2.1 Obtaining Software Packages.

l The installation package has been uploaded to the Linux, VMware ESXi, or Microsoft
Windows.

Installing hifcadm on Linux

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Install the hifcadm tool.

If the OS is RHEL, CentOS, Oracle, SUSE, UVP, RedFlag, or Neokylin, run the rpm -ivh
<driver software package name> command to install the hifcadm tool.

Using RHEL as an example:
# rpm -ivh hifcadm-1.2.3.0-1.x86_64.rpm
Preparing...                              ######################## [100%]
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Updating / installing...
       1:hifcadm-1.2.3.0-1                ######################## [100%]

----End

Installing hifcadm on (Linux) Ubuntu/Linx

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Run the dpkg -i hifcadm-<version>-<release>.<arch>.debcommand to install the hifcadm
tool.

Example:

root@ubuntu1804:~# dpkg -i hifcadm-1.8.2.3-1.x86_64.deb  
Selecting previously unselected package hifcadm.
(Reading database ... 65981 files and directories currently installed.)
Preparing to unpack hifcadm-1.8.2.3-1.x86_64.deb ...
Unpacking hifcadm (1.8.2.3) ...
Setting up hifcadm (1.8.2.3) ...
Installing... Please wait for a moment.
Install hifcadm tool successfully.

----End

NOTE

If the hifcadm tool cannot be used, check whether the hifcadm tool is running in the root user.

Installing hifcadm on Microsoft Windows

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the directory where the msi package is stored, for example, C:\.

Step 3 Double-click hifcadm_<version>x86_64.msi to install the hifcadm tool. During the

installation, click  on the task bar and click Install in the displayed window to install the
7z-Zip tool. You can use 7z-Zip to compress and parse logs. The default installation path is C:
\Program Files (x86)\hifcadm.

NOTE

The default installation path includes the hifcadm tool, log collection script collect_log_hifcadm.exe,
and log packing tool 7z.

----End

3.2 Using hifcadm

Command Format
The hifcadm supports the following command format:

hifcadm <major cmd> <minor cmd> <parameter> …<minor cmd> <parameter>

The command function is determined by the major command (major cmd) and minor
commands (minor cmd).
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NOTE

On Microsoft Windows, you cannot double-click hifcadm.exe to use to the tool. The following
describes how to use the commands on Microsoft Windows:

1. Run cmd to open the command line interface (CLI), right-click the title bar and choose Properties
from the menu, click the Layout tab, and set Width under Screen Buffer Size to 999 to ensure that
the command output format is correct.

2. Go to the tool installation directory, for example, C:\Program Files (x86)\hifcadm.

3. Enter hifcadm.exe<major cmd> <minor cmd> <parameter> …<minor cmd> <parameter>.

Obtaining Help Information

When using the hifcadm tool, you can use the following commands to obtain help
information:

l Obtaining the tool version information

Short command: hifcadm -v
Long command: hifcadm --version

l Obtaining the list of major commands supported by the tool

Short command: hifcadm -h
Long command: hifcadm --help

l Obtaining the list of minor commands supported by the tool

Short command: hifcadm <major cmd> -h
Long command: hifcadm <major cmd> --help
In addition, you can add -h to any major command to obtain the value ranges of all
minor commands and the parameters in the commands.

3.3 Command List
Table 3-1 lists the major commands and their functions supported by hifcadm on Linux.

Table 3-1 Major hifcadm commands on Linux

Major Command Function

version Queries version information.

info Queries the system device list or the basic information
about a specified device.

log Obtains online logs and parses offline logs.

updatefw Upgrades and activates the firmware.

counter Collects statistics.

temperature Queries the chip temperature.

clear Clears statistics.

fc_allinfo Queries information about all FC ports.
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Major Command Function

fc_port Resets, enables, or disables a port.

fc_topo Changes the port topology mode.

fc_speed Sets the link rate.

fc_port_info Queries the port status.

fc_port_clear Clears port error code statistics.

fc_sfpinfo Queries information about the optical module connected to
an optical port.

fc_fec Queries and enables the FEC function when the rate is
16G.

fc_bbscn Queries and enables the credit recovery function.

fc_dfx Queries and clears the port statistics of the SP520, SP521,
or SP522.

fc_dif Sets the switching status of DIF.

fc_dif_config Configures other DIF functions.

fc_port_monitor Queries I/O statistics of an IN300 port.

fc_dumpmac Collects FC MAC logs of an IN300 card.

hilink_param Queries the ctle, ffe, and dfe parameters of the device.

fe_epc Obtains Fusion Engine (FE) error information.

serdes Obtains port serdes information.

fc_vport Sets the NPIV feature of a specified port.

fc_qos Queries and sets the QoS function of a specified port.

fc_delay Queries connection delay of a specified port.

fc_savedata Saves and deletes the configuration of a specified port.

fc_portstat Queries the session information of a specified port.

fc_portxchg Queries the xchg information of a specified port

csr_dump Reads and saves chip register values in batches.

fc_set_link_tmo Sets the Link Timeout Period Permanently

fc_get_link_tmo Queries the Link Timeout Interval

fc_set_loglevel Sets the Driver Log Level

fc_get_loglevel Queries the Driver Log Level

reg Querying the RegisterInformation of a Specified Device
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Table 3-2 lists the major commands and their functions supported by hifcadm on VMware
ESXi.

Table 3-2 Major hifcadm commands on VMware ESXi

Major Command Function

version Queries version information.

info Queries the system device list or the basic information
about a specified device.

log Obtains online logs and parses offline logs.

updatefw Upgrades and activates the firmware.

counter Collects statistics.

temperature Queries the chip temperature.

clear Clears statistics.

fc_allinfo Queries information about all FC ports.

fc_port Resets, enables, or disables a port.

fc_topo Changes the port topology mode.

fc_speed Sets the link rate.

fc_port_info Queries the port status.

fc_port_clear Clears port error code statistics.

fc_sfpinfo Queries information about the optical module connected to
an optical port.

fc_bbscn Queries and enables the credit recovery function.

fc_dfx Obtains the FC port statistics count.

fc_port_monitor Queries I/O statistics of an IN300 port.

fc_dumpmac Collects FC MAC logs of an IN300 card.

hilink_param Queries the ctle, ffe, and dfe parameters of the device.

fe_epc Obtains FE error information.

serdes Obtains port serdes information.

fc_qos Queries and sets the QoS function of a specified port.

fc_delay Queries connection delay of a specified port.

fc_fec Queries and enables the FEC function when the rate is
16G.
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Major Command Function

fc_portstat Queries the session information of a specified port.

fc_portxchg Queries the Xchg information of a specified port

 

Table 3-3 lists the major commands and their functions supported by hifcadm on Microsoft
Windows.

Table 3-3 Major hifcadm commands on Microsoft Windows

Major Command Function

version Queries version information.

info Queries the system device list or the basic information
about a specified device.

log Obtains online logs and parses offline logs.

updatefw Upgrades and activates the firmware.

counter Collects statistics.

temperature Queries the chip temperature.

clear Clears statistics.

fc_allinfo Queries information about all FC ports.

fc_port Resets, enables, or disables a port.

fc_topo Changes the port topology mode.

fc_speed Sets the link rate.

fc_port_info Queries the port status.

fc_port_clear Clears port error code statistics.

fc_sfpinfo Queries information about the optical module connected to
an optical port.

fc_bbscn Queries and enables the credit recovery function.

fc_dfx Obtains the FC port statistics count.

fc_port_monitor Queries I/O statistics of an IN300 port.

fc_dumpmac Collects FC MAC logs of an IN300 card.

hilink_param Queries the ctle, ffe, and dfe parameters of the device.

fe_epc Obtains FE error information.

serdes Obtains port serdes information.
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Major Command Function

fc_qos Queries and sets the QoS function of a specified port.

fc_delay Queries connection delay of a specified port.

fc_portstat Queries the session information of a specified port.

fc_fec Queries and enables the FEC function when the rate is 16
Gbit/s.

fc_portxchg Queries the Xchg information of a specified port

 

3.4 Command Reference
This section describes the meanings, parameters, and usage of the common commands of the
hifcadm tool. For more information about the commands, you can run the -h command on the
hifcadm.

NOTE

On Microsoft Windows, you cannot double-click hifcadm.exe to use to the tool. The following
describes how to use the commands on Microsoft Windows:
1. Run cmd to open the command line interface (CLI), right-click the title bar and choose Properties

from the menu, click the Layout tab, and set Width under Screen Buffer Size to 999 to ensure that
the command output format is correct.

2. Go to the tool installation directory, for example, C:\Program Files (x86)\hifcadm.
3. Enter hifcadm.exe<major cmd> <minor cmd> <parameter> …<minor cmd> <parameter>.

3.4.1 Querying the Version Information of a Device (version)

Function
The version command is used to query the version information about the IN300 driver,
firmware, and management tools.

Format
hifcadm version -i <devicename>

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1

 

Usage Instruction
None
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Example
# Query the version information of a specified IN300.

[root@localhost final]# hifcadm version -i hifc0
boot: 1.2.3.0 2018-02-07_21:45:47
up: 1.2.3.0 2018-02-07_21:45:47
ucode: 1.2.3.0 2018-02-07_21:45:47
hifcadm tool: 1.2.3.0
hifc_sdk driver: 1.2.3.0
hifc driver: 1.2.3.0

3.4.2 Querying Basic Information (info)

Function
The info command is used to query information about all IN300 cards or a specified IN300 on
a server.

Format
hifcadm info

hifcadm info -i <devicename>

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1

 

Usage Instruction
None

Example
# Query information about all IN300 cards in the server.

[root@localhost final]# hifcadm info
Card num:1
Hi1822 device Information:   
         Card      PCIe Function 
|---- hifc0(FC_32G) 
          |--------0000:83:00.0(FC:hifc0000) 
          |--------0000:84:00.0(FC:hifc0001)
|---- hifc1(FC_32G) 
          |--------0000:88:00.0(FC:hifc0100) 
          |--------0000:8a:00.0(FC:hifc0101)

# Query the basic information of a specified IN300.

[root@localhost final]# hifcadm info -i hifc0
Card information:   
card type      : FC_32G 
port num       : 2 
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port speed     : 32GE 
pcie width     : 8 
host num       : 1 
pf num         : 2 
vf total num   : 5
tile num       : 2 
qcm num        : 6 
core num       : 4 
work mode      : 2 
service mode   : 6 
pcie mode      : X16_MODE 
cfg addr       : 0x20000 
boot sel       : 0

3.4.3 Collecting Logs (log)

3.4.3.1 Collecting All Firmware Logs of a Specified Device (-a)

Function
The log -a command is used to collect all firmware logs of a specified device, including the
firmware and microcode logs of the RAM and flash memory as well as the last words of the
firmware and microcode.

The collected logs are automatically saved to the installation directory of the tool.

The logs collected in Windows are stored in the C:\Program Files (x86)\hifc directory.

Format
hifcadm log -i <devicename> -a

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1

 

Usage Instruction
None

Example
# Query all logs on a specified IN300.

[root@localhost final]# hifcadm log -i hifc0 -a
/opt/hifc/fwlog/up_ram_hifc0_2018_02_11_17_56_19.log create succeed. 
/opt/hifc/fwlog/up_flash_hifc0_2018_02_11_17_56_20.log create succeed.
/opt/hifc/fwlog/ucode_ram_hifc0_2018_02_11_17_56_20.log create succeed. 
/opt/hifc/fwlog/ucode_flash_hifc0_2018_02_11_17_56_20.log create succeed. 
/opt/hifc/fwlog/up_lastword_flash_hifc0_2018_02_11_17_56_20.log create succeed. 
/opt/hifc/fwlog/ucode_lastword_flash_hifc0_2018_02_11_17_56_20.log create succeed. 
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3.4.3.2 Collecting Logs of a Specified Type (-t)

Function

The log -t command is used to collect logs of a specified type and save the collected logs to
the installation directory of the tool.

The logs collected in Windows are stored in the C:\Program Files (x86)\hifc directory.

Format

hifcadm log -i <devicename> -t <logtype>

Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1

logtype Indicates the type of logs to
be collected.

l 0: indicates the firmware logs in the
RAM.

l 1: indicates the firmware logs in the
flash memory.

l 2: indicates the microcode logs in the
RAM.

l 3: indicates the microcode logs in the
flash memory.

l 4: indicates the last words of the
firmware and microcode.

 

Usage Instruction

None

Example

# Query the firmware logs in the flash memory on a specified IN300.

[root@localhost final]# hifcadm log -i hifc0 -t 1
/opt/hifc/fwlog/ up_flash_hifc0_2018_02_11_17_05_41.log create succeed.

3.4.3.3 Parsing Run Logs Offline (-o1)

Function

The log -o1 command is used to parse firmware and microcode run logs offline and save the
parsing results to the installation directory of the tool.
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Format
hifcadm log -o1 <logfile> -m <mgmt_index> -u <ucode_index>

Parameters
Parameter Description Value

logfile Indicates the name of the log file to be parsed.
NOTE

This file is the out-of-band run log file of the IN300 obtained
using the one-click information collection function of the
iBMC. For details about the file obtaining method and save
path, see the iBMC User Guide.

Example:
err_log.bin

mgmt_index Indicates the firmware index file corresponding to the
log file to be parsed.
NOTE

The archive address and download method of this file are the
same as those of the IN300 driver and firmware. For details, see
2.1 Obtaining Software Packages.

Example:
up_index

ucode_index Indicates the microcode index file corresponding to the
log file to be parsed.
NOTE

The archive address and download method of this file are the
same as those of the IN300 driver and firmware. For details, see
2.1 Obtaining Software Packages.

Example:
ucode_index

 

Usage Instruction
Before running this command, transfer the log files and index files to be parsed to the
installation directory of the tool.

When running this command, you can specify either -m or -u or both.

Example
# Parse the logs of the IN300 offline.

[root@localhost final]# hifcadm log -o1 error_log.bin -m up_index -u ucode_index
/opt/hifc/fwlog/ up_ram_offline_2018_01_15_18_52_32.log create succeed.
/opt/hifc/fwlog/ up_flash_offline_2018_01_15_18_52_32.log create succeed.
/opt/hifc/fwlog/ ucode_ram_offline_2018_01_15_18_52_32.log create succeed.
/opt/hifc/fwlog/ ucode_flash_offline_2018_01_15_18_52_32.log create succeed.
[root@localhost final]# /opt/hifc/fwlog # ls
/opt/hifc/fwlog/ up_ram_offline_2018_01_15_18_52_32.log create succeed.
/opt/hifc/fwlog/ up_flash_offline_2018_01_15_18_52_32.log create succeed.
/opt/hifc/fwlog/ ucode_ram_offline_2018_01_15_18_52_32.log create succeed.
/opt/hifc/fwlog/ ucode_flash_offline_2018_01_15_18_52_32.log create succeed.

Huawei IN300 FC HBA Card
User Guide 3 Management Tool hifcadm

Issue 08 (2019-07-27) Copyright © Huawei Technologies Co., Ltd. 34



3.4.3.4 Parsing Last Words Offline (-o2)

Function

The log -o2 command is used to parse firmware and microcode last words offline and save the
parsing results to the installation directory of the tool.

Format

hifcadm log -o2 <logfile>

Parameters

Parameter Description Value

logfile Indicates the name of the last-word file to be parsed.
NOTE

This file is the out-of-band last-word file of the IN300 obtained
using the one-click information collection function of the
iBMC. For details about the file obtaining method and save
path, see the iBMC User Guide.

Example:
last_word.bin

 

Usage Instruction

Before running this command, transfer the last-word files and index files to be parsed to the
installation directory of the tool.

Example

# Parse the last words of the IN300 offline.

[root@localhost final]# hifcadm log -o2 last_word.bin
/opt/hifc/fwlog/ ucode_lastword_flash_offline_2018_01_15_18_58_25.log create 
succeed.
/opt/hifc/fwlog/ up_lastword_flash_offline_2018_01_15_18_58_25.log create succeed.
[root@localhost final]# /opt/hifc/fwlog # ls
ucode_lastword_flash_offline_2018_01_15_18_58_25.log
up_lastword_flash_offline_2018_01_15_18_58_25.log

3.4.3.5 Collecting Windows Driver Logs (-path)

Function

The log -path command is used to collect Windows driver logs and save the logs in the
directory where the tool is installed.

Format

hifcadm log -path <logpath\\>
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Parameters

Parameter Description Value

logpath\\ Name of the folder (in the directory where the tool is
installed) for storing the collected logs.

For example:
drv_log\\

 

Usage Instruction

In the CMD window, navigate to the directory where the tool is installed.

Example

#Collect Windows driver logs.

C:\Program Files(x86)\hifcadm>hifcadm.exe log -path drv_log\\

3.4.4 Upgrading Firmware (updatefw)

Function

The updatefw command is used to upgrade firmware.

Format

hifcadm updatefw -i <devicename> -f <fwfile> [-a <activemode>]

Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 to be upgraded in the
system.

Example: hifc0 and hifc1

fwfile Indicates the path to the
firmware upgrade package.

Format: Path/Upgrade
package name

activemode Indicates the effective mode of
the hot upgrade.

l now: The setting takes
effect immediately after
the upgrade.

l later: The setting does
not take effect
immediately after the
upgrade, and will be
manually activated after
the upgrade.
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Usage Instruction
l If the -a parameter is not specified, the common upgrade mode is used. After the upgrade

is complete, restart the OS for the upgrade to take effect.
l If the -a parameter is specified, the hot upgrade mode is used.

– If the effective mode is now, the setting takes effect immediately after the upgrade.
– If the effective mode is later, the upgrade does not take effect immediately after the

upgrade, and will take effect after you run the hifcadm updatefw -i <devicename>
-a now command.

– The hot upgrade can be performed only when any differences exist between
minimum versions, such as 1.3.7.x and 1.3.7.y.

l Currently, only parameters and functions described in this document are supported.

Example

# Upgrade the Huawei IN300 2*16Gb firmware.

[root@localhost final]# hifcadm updatefw -i hifc0 -f fc_prd_1h_2x16G.bin -a now
Please do not remove driver or network device.
Loading...[>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>] [100%][\]
Do not operate the device during the hot upgrade.
Firmware is activing. 
Please waiting...

3.4.5 Querying Statistics (counter)

3.4.5.1 Querying the Statistics of a Specified Device (-t, -x)

Function

The counter command is used to query all statistics of a specified device, including the MIB,
microcode, firmware, and IPSU statistics.

The counter -t command is used to query the statistics of a specified device type.

The counter -t -x command is used to query the statistics of a specified sequence of a
specified device type.

Format

hifcadm counter -i <devicename>

hifcadm counter -i <devicename> -t <countertype>

hifcadm counter -i <devicename> -t <countertype> -x <counterindex>

Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1
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Parameter Description Value

countertype Indicates the statistics type. l 0: firmware statistics
l 1: microcode statistics

counterindex Indicates the statistics
sequence.

You can run the counter -h
command to obtain the
value range.

 

Usage Instruction
None.

Example
# Query all statistics of the IN300.

[root@localhost final]# hifcadm counter -i hifc0

uP Statistics:  

uP Common Counter:  
pcie:module_except: 2
upcomm:module_except: 60
general_level_except: 2
suggest_level_except: 60
common:cnt_up_i2c_rx_full: 60

uP FC Counter:  
port0:tx_sn_speed: 32
port0:rx_sn_speed: 32

# Query the microcode statistics of the IN300.

[root@localhost final]# hifcadm counter -i hifc0 -t 1

uCode Statistics:  
FC Global Counter:  
fc_sqe_consumer: 2
fc_exch_time_out: 34
fc_hash_loopup_failed: 1

FC Functional Counter:  
port0:fc_init_srqc: 2
port0:fc_init_scqc: 34
port0:fc_del_scqc: 1
port0:fc_clear_srq: 1
...

# Query the statistics of a specified sequence of the microcode type of the IN300.

[root@localhost final]# hifcadm counter -i hifc0 -t 1 -x 22

uCode Statistics:  

FC Global Counter:  
fc_sqe_consumer: 2
fc_exch_time_out: 34
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3.4.5.2 Parsing Inspection Information Offline (-o)

Function
The counter -o command is used to parse inspection information offline and save the parsing
results to the installation directory of the tool.

Format
hifcadm counter -o <countfile>

Parameters
Parameter Description Value

countfile Indicates the name of the inspection file to be parsed.
NOTE

This file is the out-of-band inspection information file of the
IN300 obtained using the one-click information collection
function of the iBMC. For details about the file obtaining
method and save path, see the iBMC User Guide.

Example:
running_log.bi
n

 

Usage Instruction
Before running this command, transfer the inspection information file to be parsed to the
installation directory of the tool.

Example
# Parse the inspection information of the IN300 offline.

[root@localhost final]# hifcadm counter -o running_log_20180206095647.bin
/opt/hifc/fwlog/inspection_info_bmc_offline_2018_02_07_10_22_38.log create 
succeed.

3.4.6 Querying the Chip Temperatures (temperature)

Function
The temperature command is used to query the chip temperature of a specified IN300.

Format
hifcadm temperature -i <devicename>
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Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1

 

Usage Instruction
None

Example
# Query the chip temperature of the IN300.

[root@localhost final]# hifcadm temperature -i hifc0
current temperature (unit: degree centigrade)
controller: 49 

3.4.7 Clearing Statistics of a Specified Device (clear)

Function
The clear command is used to clear the statistics of a specified type of a specified device
type.

Format
hifcadm clear -i <devicename> -t <countertype>

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 whose statistics are to
be cleared in the system.

Example: hifc0 and hifc1

countertype Indicates the statistics type to
be cleared.

l 0: asynchronous
information statistics

l 1: DFX information
statistics

 

Usage Instruction
None

Example
# Clear the asynchronous event statistics of the IN300.
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[root@localhost final]# hifcadm clear -i hifc0 -t 0
Clear event stats info succeed.

3.4.8 Querying Information About All FC Ports (fc_allinfo)

Function

The fc_allinfo command is used to query information about all IN300 FC ports on a server.

Format

hifcadm fc_allinfo

Usage Instruction

None

Example

# Query information about all the FC ports on a server.

[root@localhost final]# hifcadm fc_allinfo

3.4.9 Setting the Status of a Specified Port (fc_port)

Function

The fc_port command is used to set the status of an IN300 FC port, including resetting,
enabling, or disabling the port.
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Format
hifcadm fc_port -i <devicename> -m <modetype> -s <portstate>

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 FC port whose status is
to be set in the system.

Example: hifc0000 and
hifc0001

modetype Indicates the operation type. l 1: reset
l 2: enable or disable

portstate Indicates the port status to be
set when modetype is 2.

l 0: disable
l 1: disable

 

Usage Instruction
None

Example
# Reset an IN300 port.

[root@localhost final]# hifcadm fc_port -i hifc0001 -m 1
[hifc0001]reset fcport_succeed

# Enable an IN300 port.

[root@localhost final]# hifcadm fc_port -i hifc0001 -m 2 -s 1
[hifc0001]turn on sfp succeed

# Disable an IN300 port.

[root@localhost final]# hifcadm fc_port -i hifc0001 -m 2 -s 0
[hifc0001]turn off sfp succeed

3.4.10 Changing the Topology Mode of a Specified Port (fc_topo)

Function
The fc_topo command is used to change the topology mode of a specified IN300 port.

Format
hifcadm fc_topo -i <devicename> -t <topomode>
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Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 FC port whose
topology mode is to be set in
the system.

Example: hifc0000 and hifc0001

topomode Indicates the topology mode
to be set.

l 3: loop
l 12: non-loop
l 15: adaptive

 

Usage Instruction

None

Example

# Set the topology mode of an IN300 FC port to Loop.

[root@localhost final]# hifcadm fc_topo -i hifc0001 -t 3
[hifc0001]set topo[Loop] succeed

3.4.11 Setting the Rate of a Specified Port (fc_speed)

Function

The fc_speed command is used to set the rate for an IN300 FC port.

Format

hifcadm fc_speed -i <devicename> -s <speedvalue>

Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 FC port whose rate is
to be set in the system.

Example: hifc0000 and
hifc0001

speedvalue Indicates the port rate to be
set.

l 0: adaptive
l 2: 2 Gbit/s
l 4: 4 Gbit/s
l 8: 8 Gbit/s
l 16: 16 Gbit/s
l 32: 32 Gbit/s
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Usage Instruction

None

Example

# Set the rate of an IN300 FC port to 8 Gbit/s.

[root@localhost final]# hifcadm fc_speed -i hifc0001 -s 8
[hifc0001]set speed[8G] succeed

3.4.12 Querying the Status of a Specified Port (fc_port_info)

Function

The fc_port_info command is used to query the status information of a specified IN300 FC
port.

Format

hifcadm fc_port_info -i <devicename>

Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 FC port whose status
is to be queried in the
system.

Example: hifc0000 and
hifc0001

 

Usage Instruction

None

Example

# Query the status of an IN300 FC port.

[root@localhost tool]# hifcadm fc_port_info -i hifc0001
[hifc0001]link up [topo]=P2P_D [speed]=16Gbps
[hifc0001]Get port info succeed

3.4.13 Clearing Error Code Information of a Specified Port
(fc_port_clear)

Function

The fc_port_clear command is used to clear the error code information of a specified IN300
FC port.
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Format

hifcadm fc_port_clear -i <devicename>

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 FC port whose error
code information is to be
cleared in the system.

Example: hifc0000 and
hifc0001

 

Usage Instruction

None

Example

# Clear the error code information of an IN300 FC port.

[root@localhost final]# hifcadm fc_port_clear -i hifc0001
[hifc0001]clear port stat succeed

3.4.14 Querying the Optical Module Information of a Specified
Port (fc_sfpinfo)

Function

The fc_sfpinfo command is used to query the optical module information of a specified
IN300 FC port.

Format

hifcadm fc_sfpinfo -i <devicename>

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 FC port whose
optical module information
is to be queried in the
system.

Example: hifc0000 and
hifc0001

 

Usage Instruction

None
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Example
# Query the optical module information of an IN300 FC port.

[root@local host final]# hifcadm fc_sfpinfo -i hifc0000
--------------------show sfp info------------------
Vendor name:      AVAGO
Vendor OUI:       00176a
Serial Num:       AD1631305G7
Date:             20160804
Bitrate:          8500
Temperature:      28 (  -10 Y,   95 Y) 
Vcc(mV):          3296 ( 2970 Y, 3630 Y)
Tx pow(uW):       564 (  100 Y,  700 Y)
Tx bias(uA):      6160 ( 2000 Y,10500 Y)
Rx pow(uW):       0 (   49 N, 1100 Y)
Id:             0x03
IdExt:          0x04
Connector:      0x07
Encoding:       1
RateIdentifier: 0
LengthSmfKm:    0(km)
LengthSmf:      0(100m)
LengthSmfOm2    5(10m)
LengthSmfOm1    3(10m)
LengthCable:    0(m)
LengthOm3       15(10m)
Transceiver     0
aucVendorRev:     G2.3
aucWaveLength:    850
UnAllocated:    0
CcBase:         207
------------Get sfp information succeed-------------

3.4.15 Querying and Setting the FEC Mode of a Specified Port
(fc_fec)

Function
The fc_fec command is used to query and set the FECViaTTS mode of a specified Huawei
IN300 2*16Gb, and Huawei IN300 2*32Gb FC port running at 16 Gbit/s.

The Huawei IN300 2*8Gb does not support this command.

Format
hifcadm fc_fec -i <devicename> -m <mode>

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 FC port whose
FECViaTTS mode is to be
queried or set in the system.

Example: hifc0000 and
hifc0001
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Parameter Description Value

mode Indicates the FEC mode to
be set.

l 0: Disable the FECViaTTS
mode.

l 1: Enable the FECViaTTS
mode.

l 2: Query the enabling
status of the current
FECViaTTS mode.

 

Usage Instruction

None

Example

# Query the FEC mode of an Huawei IN300 2*16Gb/Huawei IN300 2*32Gb FC port.

[root@localhost final]# hifcadm fc_fec -i hifc0001 -m 2
Current FC 16G FECViaTTS mode is 0

# Enable the FEC mode of an Huawei IN300 2*16Gb/Huawei IN300 2*32Gb FC port.

[root@localhost final]# hifcadm fc_fec -i hifc0001 -m 1
Set FC 16G FECViaTTS mode(1) successed
Please reset port. Mode will be valid after reset port

3.4.16 Querying and Setting the BB_SC_N Function of a Specified
Port (fc_bbscn)

Function

The fc_bbscn command is used to query and configure the BB_SC_N parameters of a
specified IN300 FC port.

After the parameters are configured, the BB_Credit Recovery function is enabled.

Format

hifcadm fc_bbscn -i <devicename> -m <mode> -v <value>

Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 FC port whose
BB_SC_N function is to be
queried or set in the system.

Example: hifc0000 and
hifc0001
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Parameter Description Value

mode Specifies whether to set or
query the BB_SC_N
function.

l 0: Set the BB_SC_N
function.

l 1: Query BB_SC_N
parameters.

value Indicates the BB_SC_N
value to be set.

0 to 14

 

Usage Instruction
None

Example
# Query the BB_SC_N parameters of an IN300 FC port.

[root@localhost final]# hifcadm fc_bbscn -i hifc0000 -m 1
Link FC BBSCN value is 0
Configured FC BBSCN value is 0

# Set the BB_SC_N value for an IN300 FC port.

[root@localhost final]# hifcadm fc_bbscn  -i hifc0000 -m 0 -v 12
Set FC BBSCN value(12) successed

3.4.17 Querying and Clearing the Statistics of a Specified Port
(fc_dfx)

Function
The fc_dfx command is used to query and clear the statistics of a specified IN300 FC port.

Format
hifcadm fc_dfx -i <devicename> -m <countertmode> [-s <sessionid>] [-c <cleartype>]

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 FC port whose
statistics is to be queried in
the system.

Example: hifc0000 and
hifc0001

Huawei IN300 FC HBA Card
User Guide 3 Management Tool hifcadm

Issue 08 (2019-07-27) Copyright © Huawei Technologies Co., Ltd. 48



Parameter Description Value

countertmode Indicates the type of the
statistics to be queried.

l 0: WQE receiving or
sending count

l 1: WQE receiving or
sending error count

l 2: error status count on the
uP management module

l 3: connection status count
l 4: I/O statistics of the host
l 5: I/O statistics of a

specified session of a host
l 6: DIF error statistics

sessionid ID of the session to be
queried when
countertmode is set to 5.

-

cleartype Indicates the type of statistics
to be cleared when
countertmode is set to 6.

The value can only be 1,
which indicates the cleared
DIF error count.

 

Usage Instruction

None

Example

# Query the statistics of an IN300 FC port.

[root@localhost final]# hifcadm fc_dfx -i hifc0000 -m 1
HBA WQE and SCQE error statistic:  
HIFC_RECV_IRESP                          : 512

Total WQE error type number=1

HIFC_STAT_CTXT_FLUSH_DONE                : 0
HIFC_STAT_ROOT_SQ_EMPTY_T0               : 0
HIFC_STAT_LAST_GS_SCQE                   : 4300
...

3.4.18 Setting the Switching Status of DIF (fc_dif)

Function

The fc_dif command is used to switch on or off DIF for all SP520s or SP521s on the current
server. Enable DIF to protect the integrity of data read or written between hosts and disks.

The 8-byte DIF field consists of a two-byte Guard Tag, a two-byte App Tag, and a four-byte
Ref Tag. After the function is enabled, DIF provides T10 DIF Type 1 end-to-end protection
(DIX+DIF) by default. In the DIX protection phase, IP Checksum is used to calculate the
Guard Tag information by default.
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Format
hifcadm fc_dif -s <switch>

Parameters
Parameter Description Value

switch Switching status of DIF. l 0: off
l 1: on

 

Usage Instruction
None

Example
# Switch on DIF for all IN300 cards.

[root@localhost final]# hifcadm fc_dif -s 1
DIF switch is in operation. Please wait...
Switch on FC DIF succeed

# Switch off DIF for the IN300 cards.

[root@localhost final]# hifcadm fc_dif -s 0
DIF switch is in operation. Please wait...
Switch off FC DIF succeed

3.4.19 Configuring Other DIF Functions (fc_dif_config)

Function
The fc_dif_config command is used to modify other DIF configurations for all IN300 cards.

Format
hifcadm fc_dif_config -m <mode> -o <option> [-a <algorithm>]

Parameters
Parameter Description Value

mode Indicates the DIF
function mode.

l 0: switches to the protection mode.
l 1: enables the DIF data selective check.
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Parameter Description Value

option Indicates
configuration
options in different
function modes

When switching to the protection mode:
l 0: Switch off the DIF and DIX protection

modes at the same time.
l 1: Switch on the DIF and DIX protection

modes at the same time.
l 2: Switch on the DIF protection mode.
When enabling the DIF data check:
l 0: The DIF data is not verified when app tag is

0xFFFF and ref tag is 0xFFFFFFFF. The DIF
data is verified when other values are used.

l 1: The DIF data is not verified when ref tag is
0xFFFFFFFF. The DIF data is verified when
other values are used.

l 2: The DIF data is not verified when app tag is
0xFFFF. The DIF data is verified when other
values are used.

l 3: The DIF data is verified when app tag is
0xFFFF and ref tag is 0xFFFFFFFF. The DIF
data is not verified when other values are used.

algorithm The check
algorithm is used
by the Guard tag
in the DIX when
the protection
mode is enabled.

l 0: CRC
l 1: IP checksum

 

Usage Instruction
None

Example
# Set the IN300 DIX check algorithm to CRC.

[root@localhost final]# hifcadm fc_dif_config -m 0 -o 1 -a 0
DIF&DIX(CRC algorithm) switch is in operation. Please wait...
Set FC DIF&DIX mode(0) option(1) succeed

# Verify DIF data app tag is 0xFFFF and ref tag is 0xFFFFFFFF.

[root@localhost final]# hifcadm fc_dif_config -m 1 -o 3
hifcadm fc_dif_config -m 1 -o 3
Set FC DIF&DIX mode(1) option(3) succeed
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3.4.20 Querying IO Statistics of a Specified Port (fc_port_monitor)

Function

The fc_port_monitor command is used to query I/O statistics of an IN300 port within two
minutes.

Format

hifcadm fc_port_monitor -i <devicename>

Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 port to be queried in
the system.

Example: hifc0000 and
hifc0001

 

Usage Instruction

None

Example

# Query I/O statistics of an IN300 port.

[root@localhost final]# hifcadm fc_port_monitor -i hifc0001
|  Port  |   I/O  Count   |   IOPS   | TX M/BPS | RX M/BPS |  Time  |
|hifc0001|      7567709   |   1897   |      474 |      474 |18:26:40|
 
|  Port  |   I/O  Count   |   IOPS   | TX M/BPS | RX M/BPS |  Time  |
|hifc0001|      7586673   |   1895   |      473 |      474 |18:26:50|
 
|  Port  |   I/O  Count   |   IOPS   | TX M/BPS | RX M/BPS |  Time  |
|hifc0001|      7605641   |   1898   |      474 |      474 |18:27:00|
 
|  Port  |   I/O  Count   |   IOPS   | TX M/BPS | RX M/BPS |  Time  |
|hifc0001|      7624625   |   1895   |      474 |      473 |18:27:10|
...

3.4.21 Obtaining FC MAC Logs (fc_dumpmac)

Function

The fc_dumpmac command is used to obtain the FC MAC log information of a specified
IN300. The log information is saved to the current directory after the command is executed.

Format

hifcadm fc_dumpmac -i <devicename>
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Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1

 

Usage Instruction

None

Example

# Save the FC MAC register logs of the IN300 to the current directory.

[root@localhost final]# hifcadm fc_dumpmac -i hifc0
[root@localhost final]# ls
mac_hifc0_2018_04_19_00_43_26.log

3.4.22 Querying Physical Parameters of a Device in Specified
Mode (hilink_param)

Function

The hilink_param command is used to query the ctle, dfe, and ffe parameters of a device in
specified mode.

Format

hifcadm hilink_param -i <devicename> -t<type> [-p <portid>]

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1

type Indicates the mode for the
query.

0: indicates the PCIe mode.
1: indicates the FC mode.

portid Indicates the number of a port
to be queried.

This parameter takes effect when type is
set to 1.

 

Usage Instruction

None
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Example

# Queries parameters of the PCIe mode.

[root@localhost final]# hifcadm hilink_param -i hifc0 -t 0
HI16 parameter info:  
 
 lane 0 :
     TX_FFE: pre= a;main= b;post= a
     RX_CTLE: PASSGN=-2dB; ACTGN= 6 815; BST= 9 4 4; ZA= 1 1 1; SQH= 1 1 1; 
RMBAND=     2 2 2; CMBAND= 1 1 1;
     RX_DFE1: Tap1=-2; Tap2=2; Tap3=1; Tap4=2; Tap5=0;
     RX_DFE2: Tap1=0; Tap2=0; Tap3=0; Tap4=0; Tap5=0; Tap6=0;
...

3.4.23 Querying Serdes Information of a Specified Device (serdes)

Function

The serdes command is used to query serdes information of a specified device.

Format

hifcadm serdes -i <devicename> [-t <mode> [-m <macroid>]]

Parameters
Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1

mode Indicates the mode for the
query.

l 0: query all serdes information.
l 1: query serdes information of a

specified Marco.

macroid This parameter takes effect
when type is set to 1, and
indicates the Marco ID.

0 to 4

 

Usage Instruction

None

Example

# Query serdes information.

[root@localhost final]# hifcadm serdes -i hifc0 -t 0
 
--------------------show hi16 info--------------------
 
macro is 0  dsnum is 0
cs0_csr2 = 0 (success)
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cs0_csr_51 = 0 (success)
cs0_csr54 = 12394
cs0_csr63 = 568
cs1_csr2 = 0 (success)
...

3.4.24 Obtaining FE Error Information of a Specified Device
(fe_epc)

Function

The fe_epc command is used to obtain FE error information of a specified device.

Format

hifcadm fe_epc -i <devicename> show -c <coreid> -t <tid> -n <num>

hifcadm fe_epc -i <devicename> show -b

Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1

coreid Indicates the core ID to be
queried.

-

tid Indicates the thread ID to be
queried.

-

num Indicates the number of FE
error records.

-

 

Usage Instruction

The -b is used to display all abnormal records.

Example

# Query all the error information about history FE threads of the hifc0.

[root@localhost final]# hifcadm fe_epc -i hifc0 show -b
index is: 0
index: 192
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
...
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3.4.25 Setting the NPIV Feature of a Specified Port (fc_vport)

Function

The fc_vport command is used to configure N_Port Identifier Virtualization (NPIV) features
of a IN300 port, including creating and deleting a virtual interface and setting the Quality of
Service (QoS) priority.

Format

hifcadm fc_vport -i <devicename> -m <modetype> -w <vportname> [-q <Qos>]

hifcadm fc_vport -i <devicename> -m <modetype> -d <vportindex>

hifcadm fc_vport -i <devicename> -m <modetype> -n <number > [-q <QoS>]

Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hifc0 and hifc1

modetype Indicates the operation type. l 1: Create a virtual interface.
l 2: Delete a virtual interface.
l 3: Create multiple virtual

interfaces at the same time.
l 4: Delete all virtual interfaces.

vportname Less significant 32 bits of the
WWPN of the virtual
interface to be created when
the operation type is 1.

The value can be a decimal or
hexadecimal number.
l Value range in hexadecimal

format: 0x1 to 0xFFFFFFFF
l Value range in decimal format:

1 to 4294967295

vportindex Index of the virtual interface
to be deleted when the
operation type is 2.

The value can be a decimal or
hexadecimal number.
l Value range in hexadecimal

format: 0x1 to 0x40
l Value range in decimal format:

1 to 64

number Number of virtual interfaces
to be created at the same
time when the operation type
is 3.

The value can be a decimal or
hexadecimal number.
l Value range in hexadecimal

format: 0x1 to 0x40
l Value range in decimal format:

1 to 64
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Parameter Description Value

Qos QoS priority of the virtual
port to be created when the
operation type is 1 or 3.

This configuration item is optional.
l 0: low priority (default)
l 1: high priority
l 2: medium priority

 

Usage Instruction
l The WWPN consists of the lower 32 bits (vportname) and the upper 32 bits. Ensure that

the WWPN is globally unique.
l The vportindex parameter used for deleting a virtual interface is the most significant

eight bits ([31:24]) of the virtual interface ID. The virtual interface ID can be obtained by
running the hifcadm fc_allinfo command.

l The constraints on the priority of virtual ports in the system are as follows: Number of
virtual ports with high priority ≤ Number of virtual ports with medium priority ≤
Number of virtual ports with low priority.

l Virtual port creation supports only the Fabric mode in which port topology type is point-
to-point and does not support other topologies.

l Multiple NPIVs cannot be created concurrently. You can only create NPIVs one by one.

Example
# Create a virtual port.

[root@localhost final]# hifcadm fc_vport -i hifc0000 -m 1 -w 0xFCFF0000
Create Vport(0xfcff0000) succeed

# Create a virtual port based on WWPN and set the priority to high.

[root@localhost final]# hifcadm fc_vport -i hifc0000 -m 1 -w 0xFDFF0000 -q 1
Create Vport(0xfdff0000) succeed

# Create two virtual ports at the same time.

[root@localhost final]# hifcadm fc_vport -i hifc0001 -m 3 -n 2
Create 1 Vport succeed
Create 2 Vport succeed

# Create two virtual ports at the same time and set their priority to medium.

[root@localhost final]# hifcadm fc_vport -i hifc0001 -m 3 -n 2 -q 2
Create 1 Vport succeed
Create 2 Vport succeed

# Query information about the current port.

[root@localhost final]# hifcadm fc_allinfo
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# Delete a specified virtual port.

[root@localhost final]# hifcadm fc_vport -i hifc0000 -m 2 -d 0x05  
Delete Vport(0x5) succeed

# Delete all virtual ports.

[root@localhost final]# hifcadm fc_vport -i hifc0001 -m 4
Delete all Vport succeed

3.4.26 Querying and Setting the QoS Function of a Specified Port
(fc_qos)

Function
The fc_qos command is used to query and set the quality of service (QoS) feature of a
specified port in the link and CS_CTL modes on a IN300 card.

Format
hifcadm fc_qos -i <devicename> -m <modetype> [-w <wwpn>] [-l <level>]

hifcadm fc_qos -i <devicename> -m <modetype> [-p <priority>]

Parameters
Parameter Description Value

devicename Indicates the name of the IN300
to be queried in the system.

Example: hifc0000 and hifc0001
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Parameter Description Value

modetype Operation type. l 0: Set QoS priority according to the
link (WWPN).

l 1: Query the WWPN information and
the current level of QoS priority.

l 2: Enable or disable the QoS function
in CS_CTL mode.

l 3: Query the enabling mode and
negotiation result of the current
CS_CTL.

l 4: Set the QoS priority of the LUN
based on the LUN ID (only for
VMware).

l 5: Query the QoS priority of a LUN
(only for VMware)

wwpn WWPN for the port whose QoS
priority is to be set when the
operation type is 0.

The value can be obtained by performing
operation type 1.

level QoS priority to be set when the
operation type is 0.

l 0: low priority (default)
l 1: high priority
l 2: medium priority

priority Enabling or disabling the QoS
priority function when the
operation type is 2.

l 0: disable
l 1: enable

 

Usage Instruction
l Before enabling the QoS function in CS_CTL mode, ensure that the priority has been set

according to WWPN or that the priority of the virtual port has been set by running the
fc_vport command.

l After the QoS function is enabled in CS_CTL mode, restart the port for the setting to
take effect.

l The constraints on the priority of virtual ports in the system are as follows: Number of
virtual ports with high priority ≤ Number of virtual ports with medium priority ≤
Number of virtual ports with low priority.

l The QoS cannot be configured in public loop mode.
l In the VMware system, you are not advised to set the QoS priorities of LUNs and links

at the same time.
l In the VMware system, if a LUN has multiple paths, set the QoS for all paths of the LUN

to the same value.

Example

# Query physical link information of a specified port.
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[root@localhost final]# hifcadm fc_qos -i hifc0001 -m 1
index           nportid                wwpn             level
  0               50a00         200304f938f1df29        2

# Set the priority of the current link to high based on WWPN.

[root@localhost final]# hifcadm fc_qos -i hifc0001 -m 0 -w 200304f938f1df29 -l 1
Set wwpn 200304f938f1df29 qos mode(1) succeed

# Query the CS_CTL (priority) mode (configuration mode and negotiation result mode) of a
port.

[root@localhost final]# hifcadm fc_qos -i hifc0001 -m 3
Link priority mode(1)
Configured priority mode(1)

# Disable the CS_CTL (priority) of the current port.

[root@localhost final]# hifcadm fc_qos -i hifc0001 -m 2 -p 0
Set priority mode(0) succeed
Please reset port

# Set the LUN priority to high based on the LUN ID.

[root@localhost final]# hifcadm fc_qos -i hifc0001 -m 4 -w 200304f938f1df29 -u 1 -
l 1
Set lun qos success

# Query the LUN priority.

[root@localhost final]# hifcadm fc_qos -i hifc0001 -m 5 -w 200304f938f1df29 -u 1 
lun qos is 1

3.4.27 Querying Connection Delay of a Specified Port (fc_delay)

Function

The fc_delay command is used to query the connection delay (in μs) of a specified port on a
IN300 card.

Format

hifcadm fc_delay -i <devicename> -n <nport>

Parameters
Parameter Description Value

devicename Indicates the name of the IN300
to be queried in the system.

Example: hifc0 and hifc1

nport Peer ID of the delay port to be
queried.

l If the connection delay between the
port and a switch is queried, the value
is 0xfffffc.

l If the connection delay between the
port and other Hi1822 chips is
queried, the value of this parameter is
the same as that of nProtId of the
current port. You can run the fc_qos
command to obtain the value.
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Usage Instruction

This command can be used only when the interconnected device is a fabric switch or Huawei
1822 series NIC (the NIC chip is Huawei Hi1822) and the link is available.

Example

# Query the current delay between a specified port and a switch.

[root@localhost final]# hifcadm fc_delay -i hifc0001 -n 0xfffffc
FC session delay is 500us

3.4.28 Saving and Deleting the Configuration of a Specified Port
(fc_savedata)

Function

The fc_savedata command is used to save and delete the configuration of an IN300 port.

After the host is restarted, the configuration of a port is restored to the most recently saved
configuration. The configuration includes:

l Physical port: topology mode, rate, FEC mode, BB_SC_N, and link-based QoS
information

l Virtual port: configuration and QoS information

Format

hifcadm fc_savedata -i <devicename> -m <mode>

Parameters

Parameter Description Value

devicename Indicates the name of the target
IN300 port in the system.

Example: hifc0000 and hifc0001

mode Indicates the operation type. l 0: saves the configuration of the port.
l 1: deletes the configuration of the

port.

 

Usage Instruction

None

Example

# Save the configuration of a port.
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[root@localhost final]# hifcadm fc_savedata -i hifc0000 -m 0
[hifc0000]save Info succeed

# Delete the configuration of a port.

[root@localhost final]# hifcadm fc_savedata -i hifc0000 -m 1
[hifc0000]clean saved Info succeed

3.4.29 Querying the Session Information of a Specified Port
(fc_portstat)

Function
The fc_portstat command is used to query the session information of a specified port on an
IN300 card.

Format
hifcadm fc_portstat -i <devicename> [-s <session_start>] [-e <session_end>]

Parameters
Parameter Description Value

devicename Indicates the name of the IN300
port to be queried in the system.

Example: hifc0000 and hifc0001

session_star
t

Indicates the first session to be
displayed.

The value range is 0 to 2047 and the
maximum value is the value of
session_end.

session_end Indicates the last session to be
displayed.

The value range is 0 to 2047 and the
minimum value is the value of
session_start.

 

Usage Instruction
If the -s and -e parameters are not specified, information about all sessions on the specified
port is displayed.

In the VMware system, this command is supported if the hifcadm version is 1.5.2.0 or later.

Example
#Query the information about all sessions on a specified port.

[root@ localhost final]# hifcadm fc_portstat -i hifc0000
**********Port(0x110000), Total Rport Num is 2, Init(1), offloading(0), 
offloaded(1), destroying(0)***************
 
SQ#0: Rport=0x0, XID=0x0, CID=0xffffffff, SID=0xffffffff, DID=0xffffffff, 
VPID=0x10, CMDN=0x0-0x0, STSN=0x1-0x1, COS=0x1, Offload=0x0
IoStat: Cmsn=0x0, Pmsn=0x0, DbCnt=0x0, SqeCnt=0x0, CqeCnt=0x0, InSqCnt=0xffff, 
InChipCnt=0xffff0002
 
SQ#1: Rport=0x1, XID=0x1, CID=0xc5d8e, SID=0x50e00, DID=0xfffffc, VPID=0x10, 
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CMDN=0x2-0x2, STSN=0x3-0x3, COS=0x2, Offload=0x2
IoStat: Cmsn=0xf, Pmsn=0x10, DbCnt=0x10, SqeCnt=0x10, CqeCnt=0x11, InSqCnt=0x0, 
InChipCnt=0x0

3.4.30 Quering the xchg Information of a Specified Port
(fc_portxchg)

Function

The fc_portxchg command is used to query the xchg information of a specified port on an
IN300 card.

Format

hifcadm fc_portxchg -i <devicename>

Parameters

Parameter Description Value

devicename Indicates the name of the IN300
port to be queried in the system.

Example: hifc0000 and hifc0001

 

Usage Instruction

None

Example

#Query the information about xchg on a specified port.

[root@ localhost]# hifcadm fc_portxchg -i hifc0000
Port(hifc0000), Xchg: Free=<3968>, Aborted=<0>, IniBusy=<0>, TgtBusy=<0>, 
Delay=<0>, Wait=<0>, SfsFree=<2048>, SfsBusy=<0>

3.4.31 Setting the Link Timeout Period Permanently
(fc_set_link_tmo)

Function

The fc_get_link_tmo command is used to set the link timeout interval of a specified IN300
port.

Format

hifcadm fc_set_link_tmo -i <devicename> -v <value> [-s <sync>]
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Parameters

Parameter Description Value

devicename Indicates the name of the IN300
port to be queried in the system.

Example: hifc0000 and hifc0001

value Indicates the timeout interval in
seconds.

0~90

sync Synchronized the link timeout
intervals of all ports on the
server.

l 0: Synchronized
l 1: Not synchronized

 

Usage Instruction

None

Example

# Set the link timeout interval of a specified IN300 port.

linux-p3dh:~ # hifcadm fc_set_link_tmo -i hifc0000 -v 39 -s 1
Set FC link tmo(30 -> 39) success.

NOTE

1. On Linux, you can also use a system interface to set the link timeout interval of a specified port. The
link timeout interval set by using the system interface must be less than or equal to the current value.
linux-p3dh:/sys/class/fc_host/host11 # echo 29 > dev_loss_tmo

2. If you use the hifcadm tool to set the link timeout interval on Linux, you need to restart the system
for the setting to take effect.

3.4.32 Querying the Link Timeout Interval (fc_get_link_tmo)

Function

The fc_get_link_tmo command is used to query the link timeout interval of a specified IN300
port.

Format

hifcadm fc_get_link_tmo -i <devicename>

Parameters

Parameter Description Value

devicename Indicates the name of the IN300
port to be queried in the system.

Example: hifc0000 and hifc0001
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Usage Instruction
None

Example
# Query the link timeout interval of a specified IN300 port.

linux-p3dh:~ # hifcadm fc_get_link_tmo -i hifc0000
FC link tmo value is 30

3.4.33 Setting the Driver Log Level (fc_set_loglevel)

Function
The fc_set_loglevel command is used to set the driver log level of a specified IN300 port.

Format
hifcadm fc_set_loglevel -i <devicename> -l <level> -f <frequency>

Parameters
Parameter Description Value

devicename Indicates the name of the IN300
port to be queried in the system.

Example: hifc0000 and hifc0001

level Indicates the driver log level.
When the log level is higher,
the system prints more logs.
This may affect the driver
performance. Therefore,
exercise caution when setting
the log level to a number
greater than or equal to 4.

l 0: closed
l 1: critical
l 2: error
l 3: warnning
l 4: event
l 5: major
l 6: minor
l 7: information

frequency Indicates the maximum number
of log entries that can be printed
every 2s

≥ 0

 

Usage Instruction
None

Example
# Query the driver log level of an IN300 port.

linux-p3dh:~ # hifcadm fc_set_loglevel -i hifc0000 -l 4 -f 600
Set FC log level(4 -> 4), frequnce(100 -> 600)in 2s success.
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3.4.34 Querying the Driver Log Level (fc_get_loglevel)

Function
The fc_get_loglevel command is used to query the log level of a specified IN300 port.

Format
hifcadm fc_get_loglevel -i <devicename>

Parameters
Parameter Description Value

devicename Indicates the name of the IN300
port to be queried in the system.

Example: hifc0000 and hifc0001

 

Usage Instruction
None

Example
# Query the driver log level of an IN300 port.

linux-p3dh:~ # hifcadm fc_get_loglevel -i hifc0000
FC log level is 4, frequnce is 100 in 2s

3.4.35 Reading Chip Register Values in Batches (csr_dump)

Function
The csr_dump command is used to read and save the chip register values in batches.

Format
hifcadm csr_dump -i <devicename> -m <module name> -t <type>

Parameters
Parameter Description Value

devicename Indicates the name of the
target IN300 in the system.

Example: hifc0 and hifc1

module name Module type. cpb, ipsurx, ipsutx, qu, pe, esch, mqm,
lcam, sml0, sml1, smf, tile0, ppe0, ppe1,
or all

type Register type cfg, err, merr, int, cnt, ctp, cap, hst,
mem, dummy, or all
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Usage Instruction
l Stop the services before running this command.
l Do not run this command twice on the same IN300.
l When this command is run, the registers of the chip cannot be read or written.

Example

# Read and save the register values of the hifc0 chip in batches.

linux-58og:~ # hifcadm csr_dump -i hifc0 -m all -t all
 addr:0x800100, csr name:ipsurx_indrect_ctrl, mem grp value:1, mem grp name:tpt
 addr:0x800100, csr name:ipsurx_indrect_ctrl, mem grp value:0, mem grp name:tcam
 addr:0x8030c0, csr name:ipsutx_indrect_ctrl, mem grp value:0, mem grp 
name:difx_error_ram
 addr:0xa0057c, csr name:iq_indrect_ctrl, mem grp value:0, mem grp name:srv_type
 addr:0xa0057c, csr name:iq_indrect_ctrl, mem grp value:1, mem grp name:ichn
 addr:0xa0057c, csr name:iq_indrect_ctrl, mem grp value:2, mem grp name:pre_alloc
 addr:0xa0057c, csr name:iq_indrect_ctrl, mem grp value:3, mem grp name:pc_ptr
 addr:0xa0057c, csr name:iq_indrect_ctrl, mem grp value:4, mem grp name:msg_type
 addr:0xa0057c, csr name:iq_indrect_ctrl, mem grp value:5, mem grp name:link_iq

3.4.36 Querying the RegisterInformation of a Specified Device
(reg)

Function

The reg command is used to query the current register value of a specified device.

Format

hifcadm reg -i <devicename> -t <registertype> -a <address> [-n <num>] [-c <channel>]

Parameters

Parameter Description Value

devicename Indicates the name of the
IN300 to be queried in the
system.

Example: hinic0 and
hinic1

registertype Indicates the type of the
register to be queried

l 0: mag register
l 1: read register
l 2: Indirect register

address Indicates the address of the
register to be queried

The value must be a
hexadecimal address.

num Indicates the number of
registers to be queried.

The value must range from
1 to 32.

channel Indicates the channel type of
registers to be queried.

The value must range from
0 to 1.
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Usage Instruction

If the command does not contain -n, it queries only the value of a register whose address has
been specified.

Example

# Query the current values of the three consecutive registers starting from 0x1022C in the
IN300.

[root@localhost tool]# hifcadm reg -i hifc0 -t 0 -a 0x1022c -n 3
addr:       0x1022c  
val[0] = 0x00  
val[1] = 0x00  
val[2] = 0x00

# Query the value of the read register whose address is 0x1d00000.

[root@localhost tool]# hifcadm reg -i hifc0 -t 1 -a 0x1d00000
addr:       0x1d00000  
data:       0x182219e5

3.5 Upgrading hifcadm

Prerequisites
l The hifcadm installation package has been downloaded.

For the package name and download method, see 2.1 Obtaining Software Packages.
l The installation package has been uploaded to the Linux, VMware ESXi, or Microsoft

Windows.

Constraints
l The target version must be later than the source version.
l If the target version is the same as or later than the source version, the upgrade fails.
l If you want to roll back to an earlier version, you need to uninstall the current hifcadm

and then install the new hifcadm.

Upgrading hifcadm on Linux

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Run the rpm -Uvh hifcadm-<version>-<release>.<arch>.rpm command to upgrade
hifcadm.

Example:

linux-CiyPcr:~/fc/tools/linux # rpm -Uvh hifcadm-1.1.9.0-1.x86_64.rpm
Preparing...                              ######################## [100%]
Updating / installing...
       1:hifcadm-1.1.9.0-1                ######################## [100%]

----End
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Upgrading hifcadm on (Linux) Ubuntu/Linx

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Run the dpkg -i hifcadm-<version>-<release>.<arch>.deb command to upgrade hifcadm.

----End

Upgrading hifcadm on VMware ESXi

In the VMware ESXi system, the management tool is combined with the driver package.
After the driver is upgraded, the hifcadm tool is automatically upgraded.

If an independent management tool has been installed, perform operations in 3.6 Uninstalling
hifcadm before performing operations in 3.5 Upgrading hifcadm.

Upgrading hifcadm on Microsoft

Perform operations in 3.1 Installing hifcadm and the new driver package automatically
replaces the existing one.

3.6 Uninstalling hifcadm

Uninstalling hifcadm from Linux

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the hifcadm installation directory.

Step 3 Run the rpm -e hifcadm command to uninstall hifcadm.

----End

Uninstalling hifcadm from (Linux) Ubuntu/Linx

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the hifcadm installation directory.

Step 3 Run the dpkg -r hifcadm command to uninstall hifcadm

----End

Uninstalling hifcadm from VMware ESXi

In the VMware ESXi system, the management tool is combined with the driver package.
After the driver is uninstalled, the hifcadm tool is automatically uninstalled.
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If an independent management tool package has been installed, perform the following steps to
uninstall the independent management tool before uninstalling the driver and management
tool by referring to 2.2.4 Uninstalling the Driver.

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Go to the installation directory where hifcadm is installed.

Step 3 Run the esxcli software vib remove -n huawei-esx-hifcadm command to uninstall hifcadm.

Step 4 Run the reboot command to restart VMware ESXi.

----End

Uninstalling hifcadm from Microsoft Windows

Step 1 Log in to the server OS.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Click , choose Control Panel > Programs and Features.

Step 3 Right-click the HifcadmTool program name and choose Uninstall/Change from the short-cut
menu.

----End
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4 Operations Specific to VMware ESXi

On VMware ESXi, hifcadm does not support NPIV configuration. You can use the following
method to configure the NPIV feature.

4.1 Creating an NPIV Port

4.2 Deleting an NPIV Port

4.1 Creating an NPIV Port

VMware ESXi 6.5 and Later

Step 1 Log in to the VMware ESXi WebUI.

Step 2 Click the target VM.

The VM management page is displayed, as shown in Figure 4-1.

Figure 4-1 VM management page

Step 3 Click Edit.

The Edit settings window is displayed.
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Step 4 Click VM Options.

Step 5 Choose Fiber Channel NPIV > Fiber Channel Virtual WWNs.

The dialog box for setting FC virtual WWNs is displayed, as shown in Figure 4-2.

Figure 4-2 Setting FC virtual WWNs

Step 6 Select Generate new WWNs, and set Number of WWNNs and Number of WWPNs.

Step 7 Click Save.

The VM management page is displayed.

Step 8 Click Power on.

Step 9 On the vSphere CLI of the ESXi host, run the esxcli storage core adapter list command to
check whether the NPIV port is created successfully.
vmhba64   hifc      link-up     fc.2337000c29003a28:2337000c29003b28  Second 
Level Lun ID  () virtual 
vmhba65   hifc      link-up     fc.2337000c29003a28:2337000c29003c28  Second 
Level Lun ID  () virtual

----End
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VMware ESXi 6.0

Step 1 Start VMware vSphere Client.

Step 2 Click the target VM.

The VM management window is displayed, as shown in Figure 4-3.

Figure 4-3 VM management window

Step 3 Click Edit virtual machine settings.

The Virtual Machine Properties window is displayed.

Step 4 Click the Options tab.
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Figure 4-4 Options

Step 5 Select Fibre Channel NPIV.

Step 6 Select Generate new WWNs, and set Number of WWNNs and Number of WWPNs.

Step 7 Click OK.

The VM management window is displayed.

Step 8 Click Power on the virtual machine.

Step 9 On the vSphere CLI of the ESXi host, run the esxcli storage core adapter list command to
check whether the NPIV port is created successfully.
vmhba64   hifc      link-up     fc.2337000c29003a28:2337000c29003b28  Second 
Level Lun ID  () virtual 
vmhba65   hifc      link-up     fc.2337000c29003a28:2337000c29003c28  Second 
Level Lun ID  () virtual

----End

4.2 Deleting an NPIV Port

VMware ESXi 6.5 and Later

Step 1 Log in to the VMware ESXi WebUI.
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Step 2 Click the target VM.

The VM management page is displayed, as shown in Figure 4-5.

Ensure that all VMs that have NPIV enabled are powered off.

Figure 4-5 VM management page

Step 3 Click Edit.

The Edit settings window is displayed.

Step 4 Click VM Options.

Step 5 Choose Fiber Channel NPIV > Fiber Channel Virtual WWNs.

The dialog box for setting FC virtual WWNs is displayed, as shown in

Figure 4-6.
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Figure 4-6 Setting FC virtual WWNs

Step 6 Select Temporarily disable NPIV for this virtual machine.

Step 7 Click Save.

The VM management page is displayed.

----End

ESXi 6.0

Step 1 Start VMware vSphere Client.

Step 2 Click the target VM.

The VM management window is displayed, as shown in Figure 4-7.
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Figure 4-7 VM management window

Step 3 Click Edit virtual machine settings.

The Virtual Machine Properties window is displayed.

Step 4 Click the Options tab.
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Figure 4-8 Options

Step 5 Select Fibre Channel NPIV.

Step 6 Select Temporarily disable NPIV for this virtual machine.

Step 7 Click OK.

----End
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5 Configuring SAN Boot

In the UEFI mode, IN300 supports SAN Boot. You can start an OS from a remote LUN.

5.1 Checking Whether the Current Firmware Version Supports SAN Boot

5.2 Upgrading the SAN Boot Firmware

5.3 Installing an OS on a Remote LUN

5.4 Starting the System by Using SAN Boot

5.5 Collecting Logs

5.6 Constraints

5.1 Checking Whether the Current Firmware Version
Supports SAN Boot

After the local OS is started and the FC driver is loaded, query the IN300 version by referring
to 3.4.1 Querying the Version Information of a Device (version). If the up version is
1.8.2.7 or later, SAN boot is supported.

If the up version is earlier than 1.8.2.7, see 2.3 Upgrading the Firmware to upgrade the up
version.

5.2 Upgrading the SAN Boot Firmware
To upgrade the SAN Boot firmware, see 2.3 Upgrading the Firmware.

5.3 Installing an OS on a Remote LUN

5.3.1 Installing Linux on a Remote LUN
This section describes how to create driver files and install RHEL and SLES. The methods for
other Linux OSs, such as CentOS, are similar.
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NOTE

The following uses Windows as an example. Prepare the RHEL driver DD file by referring to 5.3.1.1.1
Preparing the RHEL Driver DD File, and prepare the SLES driver DUD file by referring to 5.3.1.2.1
Preparing a SLES Driver DUD File.

5.3.1.1 Installing RHEL on a Remote LUN

5.3.1.1.1 Preparing the RHEL Driver DD File

Step 1 Obtain the RPM driver file of the RHEL OS by referring to 2.1 Obtaining Software
Packages.

Step 2 RHEL 7.4 is used as an example. Create the red7.4/rpms/x86_64 directory. Put the RPM OS
driver file in the x86_64 folder, and put the rhdd3 file in the red7.4 folder. Figure 5-1 shows
the content of the rhdd3 file.

Figure 5-1 Content of the rhdd3 file

Step 3 Use the UltraISO tool to generate an ISO file by using the red7.4 folder. The DD file is
created.

----End

5.3.1.1.2 Installing RHEL

Step 1 On the initial installation screen, select Install Red Hat Enterprise Linux 7.0, as shown in
Figure 5-2. Press E to edit the selected file.
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Figure 5-2 RHEL initial installation screen

Step 2 Add linux dd at the end of the linuxefi line, as shown in Figure 5-3. Press Ctrl+X to go to
the next step.
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Figure 5-3 Editing the selected file

Step 3 A virtual DVD-ROM drive and a virtual floppy drive (FDD) are displayed. Unmount the OS
image from the virtual DVD-ROM drive and mount the driver ISO file, as shown in Figure
5-4.

Enter r to refresh the screen and press Enter.
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Figure 5-4 Mounting the driver ISO image

Step 4 Select the DVD-ROM drive, enter 7, and press Enter.

Enter 1 and press Enter.

Enter c and press Enter.

Load the driver as prompted, as shown in Figure 5-5.
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Figure 5-5 Loading drivers

Step 5 Unmount the driver ISO image, mount the OS image, enter r to refresh the screen, and press
Enter to continue the OS installation.

Set the installation location to a remote LUN.

----End

5.3.1.2 Installing SLES on a Remote LUN

5.3.1.2.1 Preparing a SLES Driver DUD File

Step 1 Obtain the driver RPM file of the SLES OS by referring to 2.1 Obtaining Software
Packages. Upload the RPM file to the local Linux OS and run the rpm2cpio *.rpm | cpio -
idmv command to obtain the directories of the hifc.ko and hifc_sdk.ko files for creating the
DUD file.

For example, run the following command:

rpm2cpio hifc-kmp-default-1.8.2.8_k4.4.21_69-sles.x86_64.rpm | cpio -idmv

The command output is as follows:

./etc/modprobe.d/hifc-load.conf

./etc/modules-load.d/hifc-modules.conf

./lib/modules/4.4.21-69-default

./lib/modules/4.4.21-69-default/updates

./lib/modules/4.4.21-69-default/updates/hifc

./lib/modules/4.4.21-69-default/updates/hifc/hifc.ko

./lib/modules/4.4.21-69-default/updates/hifc/hifc_sdk.ko
59145 blocks
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Step 2 The following uses SLES 12 SP2 as an example. Create the linux\suse\x86_64-sles12
directory and create the install and modules folders in the x86_64-sles12 folder.
l Put the driver RPM file and the update.post file in the install folder. Figure 5-6shows

the content of the update.post file.

Figure 5-6 Content of the update.post file

l Put the hifc.ko, hifc_sdk.ko, and module.order files into the modules folder. Figure
5-7 shows the content of the module.order file.

Figure 5-7 Content of the module.order file

Step 3 Use the UltraISO tool to generate an ISO file by using the linux folder. The DUD file is
created.

----End

5.3.1.2.2 Installing SLES

Step 1 SLES 12 SP2 is used as an example. On the initial installation screen, select Installation, as
shown in Figure 5-8.

Press E to edit the selected file.
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Figure 5-8 SLES 12 SP2 initial installation screen

Step 2 Add linux dud=1 at the end of the linuxefi line, as shown in Figure 5-9.

Press Ctrl+X or F10.

Figure 5-9 Editing the selected file
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Step 3 Unmount the OS image from the virtual DVD-ROM drive, mount the prepared DUD ISO file,
click OK, and press Enter, as shown in Figure 5-10.

Figure 5-10 Mounting the DUD ISO file

Step 4 The driver loading starts.
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Figure 5-11 Loading the driver

Step 5 Mount the OS ISO file again to install the OS. On the installation location selection screen,
select a remote LUN for installation.

----End

5.3.2 Installing VMware ESXi on a Remote LUN
Step 1 Obtain the VIB driver file of the VMware ESXi OS. Use ESXi-Customizer or other ESXi ISO

customization tools to combine the VIB driver file and ESXi ISO file into a customized ISO
file.

Figure 5-12 shows how to use ESXi-Customizer to generate an ISO file. Select the path of
VMware ESXi ISO file in the first row, select the path of the VIB driver file in the second
row, select the path of the file to be generated in the third row, and click Run! to generate a
customized ISO file.

Huawei IN300 FC HBA Card
User Guide 5 Configuring SAN Boot

Issue 08 (2019-07-27) Copyright © Huawei Technologies Co., Ltd. 88



Figure 5-12 Customizing an ISO file by using ESXi-Customizer

Step 2 Use the customized ISO file to install VMware ESXi on a remote LUN.

----End

5.3.3 Installing Microsoft Windows on a Remote LUN
Step 1 Obtain the MSI driver file of Microsoft Windows by referring to 2.1 Obtaining Software

Packages.

Step 2 To obtain the original driver files from the MSI file, install the driver on a server with a
Windows OS of the required version. After the installation, obtain the FCdrivers folder from
the default installation path C:\Program Files (x86)\HifcDriver\FCdrivers, as shown in
Figure 5-13.

Figure 5-13 Driver files after the driver is installed on Windows

Step 3 Install the Windows OS on a remote LUN.

Windows Server 2012 R2 is used as an example. On the screen for selecting the installation
location, mount the FCdrivers folder to the virtual DVD-ROM drive, and click Load driver,
as shown in Figure 5-14.
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Figure 5-14 Mounting the Windows driver folder

Step 4 Select the HBA driver of the Windows OS and click OK to load the Windows driver, as
shown in Figure 5-15.

Figure 5-15 Loading the Windows driver
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Step 5 Select a remote LUN and mount the OS ISO file again to install the OS, as shown in Figure
5-16.

Figure 5-16 Remote LUN detected after the driver is loaded

----End

5.4 Starting the System by Using SAN Boot

5.4.1 Enabling SAN Boot
SAN Boot is disabled by default. Currently, SAN Boot supports only the UEFI mode. Set the
boot mode to UEFI in the BIOS and perform the following steps to enable SAN Boot.

Step 1 Access the server real-time desktop by using the remote virtual console.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Restart the server.

Step 3 When information shown in Figure 5-17 is displayed, press F11.
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Figure 5-17 Accessing the BIOS from iBMC

The BIOS front page is displayed.

Figure 5-18 Front page
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Step 4 Use the arrow keys to select Device Management and press Enter.

Figure 5-19 Device Management screen.

Step 5 Use the arrow keys to select Huawei IN300 Fibre Channel Adapter and press Enter. The
IN300 SAN Boot screen is displayed.

Boot from remote is disabled by default. Set this parameter to ENABLE. Press Esc to exit
the screen.

Figure 5-20 Enabling SAN Boot

Step 6 Restart the server.

----End
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5.4.2 Starting an OS from a Remote LUN.
Step 1 Access the server real-time desktop by using the remote virtual console.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 Restart the server.

Step 3 When information shown in Figure 5-21 is displayed, press F11.

Figure 5-21 Accessing the BIOS from iBMC

The BIOS front page is displayed.
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Figure 5-22 Front page

Step 4 Use the arrow keys to select Boot Manager and press Enter.

Select a remote OS, for example, VMware ESXi.
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Figure 5-23 Boot Manager screen

You can use the OS after it is started.

----End

5.5 Collecting Logs
Log in to the iBMC of the server, click One-Click Info Collection, wait until the log
collection is complete, and download the logs.
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Figure 5-24 One-Click Info Collection

5.6 Constraints
When SAN Boot is used for starting a remote Windows, the FC driver cannot be upgraded
directly. To upgrade the FC driver, reinstall the OS on the remote LUN by using a driver of
the required version. For details see 5.3 Installing an OS on a Remote LUN.
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6 Appendix

6.1 Logging In to the Real-Time Server Desktop

6.2 Restarting the Server

6.3 Transferring a File Using the Virtual Directory

6.1 Logging In to the Real-Time Server Desktop
To log in to the server OS, you can use the server multi-port connector to connect to the KVM
as the login terminal or use the remote console provided by the server iBMC for remote login.

The following is the procedure for using the remote console provided by the server iBMC to
log in to the real-time server desktop.

Step 1 Configure the login environment.

1. Connect the PC to the iBMC management network port using a network cable.
2. Set an IP address for the PC, and ensure that the IP address is on the same network

segment as that of the iBMC management network port.
For example, set the IP address to 192.168.2.10 and the subnet mask to 255.255.255.0.

Step 2 Log in to the iBMC WebUI.

1. Open a browser, enter https://IP address of the iBMC management network port in the
address box, and press Enter.
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Figure 6-1 iBMC login page

2. On the iBMC login page, perform the following operations:
– Select the language to be used.
– Enter the user name.
– Enter the password.
– Set Domain to This iBMC.
– Click Log In.

The iBMC WebUI home page is displayed.

Step 3 Go to the Remote Virtual Console.

1. In the navigation tree, choose Remote Control.
The Remote Control page is displayed.

2. Click the Remote Virtual Console button.
– If Java is integrated, click Java Integrated Remote Console.
– If HTML5 is integrated, click HTML5 Integrated Remote Console.
The following uses the Java integrated Remote Virtual Console as an example.
The Remote Virtual Console screen is displayed, as shown in Figure 6-2.
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Figure 6-2 Remote Virtual Console screen

----End

6.2 Restarting the Server
You can use the iBMC to power off and then power on the server for the firmware upgrade to
take effect.

Restarting the Server on the iBMC WebUI

Step 1 Log in to the iBMC WebUI.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 In the navigation tree, choose Power > Power Control.

The Power Control page is displayed, as shown in Figure 6-3.
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Figure 6-3 Power Control page

Step 3 Select Forced Power Cycle.

Step 4 Confirm the operation in the operation confirmation dialog box displayed.

----End

Restarting the Server Through the Remote Virtual Console

Step 1 Log in to the real-time server desktop using the Remote Virtual Console.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 On the toolbar of the Remote Virtual Console, click .

The power control menu is displayed, as shown in Figure 6-4.
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Figure 6-4 Power control menu

Step 3 Choose Forced Power Cycle.

Step 4 Confirm the operation in the operation confirmation dialog box displayed.

----End

6.3 Transferring a File Using the Virtual Directory
Before installing and upgrading the driver, upgrading the firmware, and installing
management tool, you need to transfer the corresponding file to the OS of the server.

The following describes how to transfer a file using the virtual directory function of the
Virtual Remote Console.

Step 1 Log in to the real-time server desktop using the Remote Virtual Console.

For details, see 6.1 Logging In to the Real-Time Server Desktop.

Step 2 On the toolbar of the Remote Virtual Console, click .

The virtual device list is displayed, as shown in Figure 6-5.

Figure 6-5 Virtual device menu

Step 3 Select Directory and click Browse.

Step 4 Select the local path where the file is.

Step 5 Click Connect.

Step 6 Copy the file to the server OS.

The device type and location of a virtual directory varies depending on the operating system
type. For details, see the official website of each respective OS vendor.

----End
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A FAQ

A.1 An Exception Occurs During Driver Installation or
Uninstallation

On the Windows OS, if the server is restarted or powered off during the driver installation or
uninstallation, the residual entries may exist in the registry. As a result, driver installation or
uninstallation may fail. You can use one of the following methods to delete the residual
registry entries:

l For exceptions during driver installation, use PsExec.exe or
MicrosoftProgram_Install_and_Uninstall.meta.diagcab to delete the residual registry
entries.

l For exceptions during driver uninstallation, use
MicrosoftProgram_Install_and_Uninstall.meta.diagcab to delete the residual registry
entries.

Use the PsExec.exe tool to delete the residual registry

Step 1 Download the PsExec.exe tool.

Step 2 Open the registry and find the name of the residual registry entry. The paths are
HKEY_LOCAL_MACHINE\DRIVERS\DriverDatabase\DriverPackages
\hifc.inf_arm64xxxx, and HKEY_LOCAL_MACHINE\SYSTEM\DriverDatabase
\DriverPackages\hifc.inf_arm64xxxx.

Step 3 Open the cmd window and run the following command to delete the residual registry entry
(hifc.inf_arm64xxxx is used as an example):

PsExec.exe -d -i -s reg delete HKEY_LOCAL_MACHINE\DRIVERS\DriverDatabase
\DriverPackages\hifc.inf_arm64xxxx /f

PsExec.exe -d -i -s reg delete HKEY_LOCAL_MACHINE\SYSTEM\DriverDatabase
\DriverPackages\hifc.inf_arm64xxxx /f

----End
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Use the MicrosoftProgram_Install_and_Uninstall.meta.diagcab tool to delete the
residual registry entries

Download the MicrosoftProgram_Install_and_Uninstall.meta.diagcab tool from the
official Windows website, and use the tool to delete the residual information generated during
the installation or uninstallation of the hifcDriver driver.

Step 1 Double-click the MicrosoftProgram_Install_and_Uninstall.meta program. On the
Program Install and Uninstall troubleshooter window, click Next.

Step 2 Click Uninstalling.
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Step 3 Select driver package whose residual information is left in the system. Click Next.

Step 4 Select Yes, try uninstall to uninstall the driver.
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Step 5 Check the repair result after the execution is complete.
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Step 6 Close the program and restart the server. The driver can be installed and uninstalled again.

----End
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B Acronyms and Abbreviations

F

FC Fiber Channel

FEC Forward Error Correction

G

GE Gigabit Ethernet

H

HBA Host Bus Adapter

HTTP Hypertext Transfer Protocol

I

I2C Inter-integrated Circuit

IOPS Input/Output Operations per Second

IP Internet Protocol

P

PCIe Peripheral Component Interconnect Express

R

RH Relative Humidity

U

UEFI Unified Extensible Firmware Interface
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